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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

www.symantec.com/business/support/
www.symantec.com/business/support/


■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com


Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Chapter 1 Introducing disk appliance storage solutions . . . . . . . . . . . . . . . 11

About storage solutions for backups to disk .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
About the NetBackup OpenStorage option .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
About control of the storage .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
About replication to OpenStorage devices ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Chapter 2 Planning your deployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Planning your OpenStorage deployment ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
About OpenStorage requirements and limitations .... . . . . . . . . . . . . . . . . . . . . . . . . . . 16
About OpenStorage storage servers for backups .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
About OpenStorage server credentials ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
About OpenStorage data movers for backups .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
About the OpenStorage plug-in ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
About OpenStorage disk pools for backups .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

About spanning volumes on OpenStorage disk pools ... . . . . . . . . . . . . . . . . . . 20
About OpenStorage duplication and replication .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

About optimized duplication within the same domain .... . . . . . . . . . . . . . . . 21
About NetBackup Auto Image Replication .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

About OpenStorage optimized synthetic backups .... . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
About OpenStorage direct to tape .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

About NDMP requirements for OpenStorage direct to tape .... . . . . . . . . 29
About media server requirements for OpenStorage direct to

tape .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
About media server recommendations for OpenStorage direct

to tape .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
About OpenStorage direct to tape limitations .... . . . . . . . . . . . . . . . . . . . . . . . . . . 32
About the OpenStorage direct to tape process ... . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Chapter 3 Provisioning the storage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

About provisioning the disk appliance storage .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Installing the disk appliance plug-in ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Contents



Chapter 4 Licensing OpenStorage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

About the OpenStorage license key .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Licensing OpenStorage .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Chapter 5 Configuring OpenStorage in NetBackup . . . . . . . . . . . . . . . . . . . . . . . . 41

Configuring OpenStorage disk appliance storage .... . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Creating NetBackup log file directories ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Configuring an OpenStorage storage server for backups .... . . . . . . . . . . . . . . . . . . 44
About the replication topology for Auto Image Replication .... . . . . . . . . . . . . . . 45
Viewing the replication topology for Auto Image Replication .... . . . . . . . . . . . 46

Sample volume properties output for OpenStorage backup
replication .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Configuring an OpenStorage disk pool for backups .... . . . . . . . . . . . . . . . . . . . . . . . . . 50
OpenStorage disk pool properties ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Configuring an OpenStorage storage unit ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
OpenStorage storage unit properties ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
About OpenStorage storage unit recommendations .... . . . . . . . . . . . . . . . . . . 56

About the storage lifecycle policies required for Auto Image
Replication .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Customizing how nbstserv runs duplication and import jobs

... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Creating a storage lifecycle policy ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Storage Lifecycle Policy dialog box settings ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Adding a storage operation to a storage lifecycle policy ... . . . . . . . . . . . . . . 65

Creating a policy using the Policy Configuration Wizard .... . . . . . . . . . . . . . . . . . 67
Creating a policy without using the Policy Configuration Wizard .... . . . . . . 67
Configuring OpenStorage optimized duplication behavior ... . . . . . . . . . . . . . . . . 68
Configuring OpenStorage optimized duplication within the same

domain .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Configuring OpenStorage direct to tape .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Configuring OpenStorage optimized synthetic backups .... . . . . . . . . . . . . . . . . . . . 73
Adding OpenStorage functionality to an existing environment .... . . . . . . . . . 73
Setting NetBackup configuration options by using bpsetconfig ... . . . . . . . . . . 74

Chapter 6 Managing OpenStorage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Managing OpenStorage storage servers ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Changing OpenStorage storage server properties ... . . . . . . . . . . . . . . . . . . . . . . 76
Deleting an OpenStorage storage server ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Determining OpenStorage storage server state ... . . . . . . . . . . . . . . . . . . . . . . . . . 77
Setting OpenStorage storage server attributes ... . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Removing OpenStorage storage server attributes ... . . . . . . . . . . . . . . . . . . . . . . 78

Contents8



Updating an OpenStorage storage server to reflect plug-in
updates ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Viewing OpenStorage storage servers ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Managing OpenStorage server credentials ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Adding OpenStorage server credentials ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Changing OpenStorage server credentials ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Deleting the OpenStorage server credentials of a data

mover ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Determining if OpenStorage server credentials exist ... . . . . . . . . . . . . . . . . . 81

Managing OpenStorage data movers ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Adding an OpenStorage data mover ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Retiring an OpenStorage data mover ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Managing OpenStorage disk pools ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Adding volumes to an OpenStorage disk pool ... . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Changing OpenStorage disk pool properties ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Changing OpenStorage disk pool state ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Changing OpenStorage disk volume state ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Deleting an OpenStorage disk pool ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Determining OpenStorage disk pool state ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Determining OpenStorage disk volume state ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Merging OpenStorage disk pools ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Removing a volume from an OpenStorage disk pool ... . . . . . . . . . . . . . . . . . . . 93
Updating an OpenStorage disk pool to reflect plug-in

updates ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Viewing OpenStorage disk pools ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Monitoring OpenStorage storage capacity and usage .... . . . . . . . . . . . . . . . . . . . . . . 94
Viewing OpenStorage disk reports ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Reporting on Auto Image Replication jobs ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
About catalog backups to OpenStorage devices ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
About restoring from backup copies ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
About restoring from a backup at a target master domain .... . . . . . . . . . . . . . . . . 98

Chapter 7 Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

About OpenStorage log files ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Troubleshooting OpenStorage credentials creation .... . . . . . . . . . . . . . . . . . . . . . . . 101

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

9Contents



Contents10



Introducing disk appliance
storage solutions

This chapter includes the following topics:

■ About storage solutions for backups to disk

■ About the NetBackup OpenStorage option

■ About control of the storage

■ About replication to OpenStorage devices

About storage solutions for backups to disk
This guide describes how to configure and use an intelligent disk appliance in
NetBackup for backups. The disk appliance must conform to the Symantec
OpenStorage API.

See “About the NetBackup OpenStorage option” on page 11.

Information about how to configure and use NetBackup with snapshots on disk
appliance storage is available in a different guide.

See the NetBackup Replication Director Solutions Guide.

About the NetBackup OpenStorage option
OpenStorage is a Symantec API that allows NetBackup to communicate with the
storage implementations that conform to the API. Storage vendors participate in
the Symantec OpenStorage Partner Program. Symantec qualifies their storage
solutions for the OpenStorage API.
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Depending on the storage implementation, OpenStorage may provide the following
capabilities:

■ Share disks. Multiple heterogeneous media servers can access the same disk
volume concurrently.

■ Balance load and performance. NetBackup balances backup jobs and storage
usage among the media servers and disk pools. For each backup job, NetBackup
chooses the least full disk volume and least busy media server.

■ Use of disk appliance capabilities, which may include optimized off-host
duplication and deduplicated storage capabilities.

■ Fast storage provisioning.

■ Almost unlimited storage.

■ Alternative to off-site vaulting.

■ Simplified disaster recovery. Access your data from anywhere over the Internet.

Figure 1-1 shows an OpenStorage configuration that uses a disk appliance.

Figure 1-1 OpenStorage appliance configuration

Load-balanced NetBackup media servers are
data movers. They have the vendor plug-in
installed.

The disk appliance is the storage
server.

Any connectivity (directly attached, SAN,
LAN)

Network

About control of the storage
The vendor's storage implementation controls the storage format and where the
images reside on the storage. The vendor controls the data transfer method.
Consequently, performance and storage utilization are highly optimized.

NetBackup has no knowledge of how the backup images are stored. Also, Symantec
does not control which capabilities the vendor exposes through the OpenStorage
API. Similarly, Symantec and NetBackup have no control over the communication
between the vendor plug-in and the storage server. The vendor determines the
API or protocol to use between the plug-in and the storage server.

Introducing disk appliance storage solutions
About control of the storage
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NetBackup determines when backup images are created, copied, or deleted. Images
cannot be moved, expired, or deleted on the storage unless NetBackup instructs
the appliance to do so through the API.

About replication to OpenStorage devices
NetBackup offers two types of replication to OpenStorage devices, as follows:

Replication of backups to another NetBackup domain is known as Auto
Image Replicaton.

Use this guide to configure Auto Image Replication of backups to an
OpenStorage device.

See “About NetBackup Auto Image Replication” on page 22.

NetBackup deduplication also supports Auto Image Replication.

See the NetBackup Deduplication Guide.

Backups

Snapshot replication within the same domain.

Use this type to replicate snapshots from one OpenStorage device to the
same device or to another device of the same vendor and type.

See the NetBackup Replication Director Solutions Guide.

Snapshots

13Introducing disk appliance storage solutions
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Planning your deployment

This chapter includes the following topics:

■ Planning your OpenStorage deployment

■ About OpenStorage requirements and limitations

■ About OpenStorage storage servers for backups

■ About OpenStorage server credentials

■ About OpenStorage data movers for backups

■ About the OpenStorage plug-in

■ About OpenStorage disk pools for backups

■ About OpenStorage duplication and replication

■ About OpenStorage optimized synthetic backups

■ About OpenStorage direct to tape

Planning your OpenStorage deployment
Table 2-1 provides an overview of NetBackup OpenStorage. This overview and
the topics to which it refers may help you plan your deployment.

Table 2-1 OpenStorage deployment

InstructionsTaskStep

See “About OpenStorage requirements and limitations” on page 16.Read about requirements and
limitations

Step 1
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Table 2-1 OpenStorage deployment (continued)

InstructionsTaskStep

See “About OpenStorage storage servers for backups” on page 17.

See “About OpenStorage data movers for backups” on page 18.

See “About OpenStorage server credentials” on page 17.

Learn about storage servers, data
movers, and credentials

Step 2

See “About OpenStorage disk pools for backups” on page 19.

See “About spanning volumes on OpenStorage disk pools” on page 20.

Learn about disk poolsStep 3

See “About OpenStorage duplication and replication” on page 21.Learn about optimized
duplication and replication

Step 4

See “About OpenStorage optimized synthetic backups” on page 27.Learn about optimized synthetic
backups

Step 5

See “About OpenStorage direct to tape” on page 28.Learn about copy to tapeStep 6

See “About provisioning the disk appliance storage” on page 35.Learn about provision the storageStep 8

See “About OpenStorage storage unit recommendations” on page 56.Learn about how storage units
can control traffic

Step 9

See “Configuring OpenStorage disk appliance storage” on page 42.See the configuration overview
topics

Step 10

About OpenStorage requirements and limitations
The following are the requirements to use the OpenStorage option:

■ A NetBackup OpenStorage Option license key.

■ Storage that is exposed to NetBackup through a software plug-in that conforms
to the Symantec OpenStorage API.

OpenStorage does not support the following:

■ Storage unit groups

■ Clustering of the media servers that function as data movers.
Multiple data movers inherently provide failover capability. Therefore,
clustering for failover is not required.

Information about supported systems is available.

See the NetBackup Release Notes.

Planning your deployment
About OpenStorage requirements and limitations
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About OpenStorage storage servers for backups
A storage server is an entity that writes data to and reads data from the storage.
It may correspond to a physical appliance or disk array. It may be a higher level
construct such as a host-based management software suite for multiple devices.
The storage server owns exclusive access to the storage.

For the OpenStorage solutions that use a disk appliance for backups, the disk
appliance host is the storage server.

How many storage servers you configure depends on your backup storage
requirements. Each disk appliance has one storage server. If you use optimized
duplication or replication, additional storage servers are required, as follows:

Optimized duplication in the same domain requires the
following storage servers:

■ One for the backup storage, which is the source for the
duplication operations.

■ Another to store the copies of the backup images. This
storage server hosts the storage that is the target for the
duplication operations.

See “About optimized duplication within the same domain”
on page 21.

Optimized duplication within
the same NetBackup domain

Auto Image Replication requires the following storage
servers:

■ One for the backups in the originating domain. This
storage server writes the NetBackup client backups to
the storage. It is the source for the duplication
operations.

■ Another in the remote domain for the copies of the
backup images. This storage server is the target for the
duplication operations that run in the originating
domain.

See “About NetBackup Auto Image Replication” on page 22.

Auto Image Replication to a
different NetBackup domain

See “About OpenStorage data movers for backups” on page 18.

About OpenStorage server credentials
When you configure a storage server in the StorageServerConfigurationWizard,
you configure its credentials.

NetBackup does the following:
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■ Saves the credentials so the media servers can log into the storage server.
If the storage server is also an NDMP FSE host for direct to tape operations,
they both must have the same logon credentials.
See “About OpenStorage direct to tape” on page 28.

■ Configures each media server you select as a data mover.
NetBackup does not monitor connectivity between data movers and the storage
server. However, when you configure the credentials, NetBackup configures
and maintains an access path between the media server and the storage server.
See “About OpenStorage data movers for backups” on page 18.

If the storage server does not require logon credentials, you must enter dummy
credentials so that NetBackup configures the media servers as data movers.

About OpenStorage data movers for backups
A data mover is a NetBackup media server that backs up a client and then transfers
the data to a storage server. The storage server then writes the data to storage.
A data mover also can move data back to primary storage (the client) during
restores and from secondary storage to tertiary storage during duplication.

The data movers host a software plug-in they use to communicate with the storage
implementation.

When you configure the storage server, you also select the media servers that
host the OpenStorage plug-in. Those media server data movers are assigned the
credentials for the storage server. The credentials allow the data movers to
communicate with the storage server. NetBackup then configures the media
servers as data movers.

You can control which data movers are used for backups and duplications when
you configure NetBackup storage units.

See “About OpenStorage storage servers for backups” on page 17.

About the OpenStorage plug-in
A software plug-in must reside on every NetBackup media server that moves
backup data to the storage server. The plug-in must conform to the Symantec
OpenStorage API specification. The vendor exposes the storage capabilities to
NetBackup through the plug-in.

To determine a disk appliance’s capabilities, NetBackup uses the plug-in to query
the storage appliance. Capabilities can include deduplicated storage, optimized
off-host duplication, and so on.
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If a vendor updates their plug-in, you must update NetBackup with the new or
changed capabilities exposed by the plug-in.

See “Updating an OpenStorage storage server to reflect plug-in updates”
on page 78.

For disk appliance storage, the appliance vendor provides the plug-in. The vendor
should provide information about how to install the plug-in.

About OpenStorage disk pools for backups
An OpenStorage disk pool represents the disk storage that is exposed to NetBackup
through the OpenStorage API.

For disk appliance storage for backups, the vendor may expose the storage as one
or more units of storage (that is, disk volumes). The vendor also may expose the
volume properties that are related to replication.

A disk pool can represent one or more volumes. If a disk pool represents more
than one volume, NetBackup selects a volume for a backup based on the available
capacity and the predicted size of the backup. NetBackup tries to write backup
data to a single volume. If necessary, backup images span volumes in a disk pool
unless the storage implementation does not support volume spanning. Backup
images do not span across multiple disk pools.

See “About spanning volumes on OpenStorage disk pools” on page 20.

How many disk pools you configure depends on your storage requirements. It
also depends on whether or not you use optimized duplication or replication, as
follows:

Optimized duplication in the same domain requires the
following disk pools:

■ At least one for the backup storage, which is the source
for the duplication operations. The source disk pool is
on one appliance.

■ Another to store the copies of the backup images, which
is the target for the duplication operations. The target
disk pool is on a different appliance.

See “About optimized duplication within the same domain”
on page 21.

Optimized duplication within
the same NetBackup domain
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Auto Image Replication disk pools can be either replication
source or replication target. The replication properties
denote the purpose of the disk pool: source or target. Your
storage administrator configures the replication topology
of the volumes in the storage devices, and you create the
disk pools to match that topology. The disk pools inherit
the replication properties from the volumes that you add
to them.

See “About the replication topology for Auto Image
Replication” on page 45.

Auto Image Replication requires the following disk pools:

■ At least one replication source disk pool in the
originating domain. A replication source disk pool is one
to which you send your backups. The backup images on
the source disk pool are replicated to a disk pool in the
remote domain.

■ At least one replication target disk pool in the remote
domain. A replication target disk pool is the target for
the duplication operations that run in the originating
domain.

See “About NetBackup Auto Image Replication” on page 22.

Auto Image Replication to a
different NetBackup domain

A disk pool is the storage destination of a NetBackup storage unit.

Figure 2-1 shows a disk pool configuration in a disk appliance.

Figure 2-1 OpenStorage disk appliance disk pools

Disk appliance DP_Gold_OpenStorage

DP_Silver_OpenStorage

See “Configuring an OpenStorage disk pool for backups” on page 50.

About spanning volumes on OpenStorage disk pools
One of the capabilities a vendor may expose is the potential for images to span
across volumes within a disk pool. NetBackup uses that capability to use the disk
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storage most effectively. NetBackup breaks up backup images into fragments and
stores a fragment or fragments if a full image does not fit into the space available.

In NetBackup, the SpanImages attribute specifies that backup images can span
across volumes in a disk pool. The SpanImages attribute applies to both storage
servers and disk pools.

Two reasons exist that may require you to update NetBackup to use the volume
spanning functionality, as follows:

■ Your OpenStorage vendor plug-in supports volume spanning functionality.
Volume spanning is not a trait that the vendor plug-in advertises. Therefore,
you must configure the storage server to use it explicitly.

■ You upgrade to a NetBackup release that supports OpenStorage volume
spanning from a release that does not support it.

In both cases, set the SpanImages attribute on both the storage server and the
disk pool.

See “Setting OpenStorage storage server attributes” on page 77.

See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 93.

About OpenStorage duplication and replication
If an OpenStorage disk appliance can copy the data on one appliance to another
appliance of the same type, NetBackup can use that capability. The following table
lists the duplication methods in NetBackup that can use the functionality:

Table 2-2 NetBackup OpenStorage duplication and replication methods

DescriptionMethod

See “About optimized duplication within the
same domain” on page 21.

Dupliation within the same NetBackup
domain

See “About NetBackup Auto Image
Replication” on page 22.

Replication to a remote NetBackup domain

About optimized duplication within the same domain
With duplication to another disk appliance within the same domain, the disk
appliances manage the deduplication. The ability to duplicate backups to storage
in other locations, often across various geographical sites, helps facilitate disaster
recovery.

The following are some benefits of optimized, off-host duplication:
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■ Reduced workload on the NetBackup media servers. More backups can be
performed.

■ Faster duplication. Duplication can occur in the background, simultaneously
with ongoing backup jobs.

■ Reduced bandwidth. If the appliance supports deduplication, the copy process
may send only changed blocks.

The requirements and limitations of optimized duplication with the same domain
are as follows:

■ The vendor must expose the off-host data movement
capability in their plug-in.

■ Both the source and the destination disk pools must be
the same OpenStorage vendor type.

■ One or more NetBackup media servers must connect to
the source appliance and the destination appliance.

Optimized duplication
requirements

■ If the optimized duplication fails, the job is not retried.

To configure NetBackup to do normal duplication if the
optimized job fails, add the following entry to the
bp.conf file on the NetBackup master server:

RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE

■ The copy operation uses the maximum fragment size of
the source storage unit, not the setting for the
destination storage unit. The optimized duplication
copies the image fragments as is. For greater efficiency,
the duplication does not resize and reshuffle the images
into a different set of fragments on the destination
storage unit.

■ To confirm the image copy, a media server must have
connectivity to the destination appliance.

■ A storage unit group cannot be a destination for
optimized duplication. The destination must be a storage
unit that represents an OpenStorage appliance of the
same type as the source appliance.

Optimized duplication
limitations

See “Configuring OpenStorage optimized duplication within the same domain”
on page 69.

About NetBackup Auto Image Replication
If your storage vendor's product supports replication, you can automatically
replicate backup images to a similar device in a different master server domain.
This process is referred to as Auto Image Replication.
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The ability to replicate backups to storage in other NetBackup domains, often
across various geographical sites, helps facilitate the following disaster recovery
needs:

■ One-to-one model
A single production datacenter can back up to a disaster recovery site.

■ One-to-many model
A single production datacenter can back up to multiple disaster recovery sites.
See “One-to-many Auto Image Replication model ” on page 24.

■ Many-to-one model
Remote offices in multiple domains can back up to a storage device in a single
domain.

■ Many-to-many model
Remote datacenters in multiple domains can back up multiple disaster recovery
sites.

Note: Although Auto Image Replication is a disaster recovery solution, the
administrator cannot directly restore to clients in the primary (or originating)
domain from the target master domain.

Table 2-3 is an overview of the process, generally describing the events in the
originating and target domains.

Table 2-3 Auto Image Replication process overview

Event descriptionDomain in which event
occurs

Event

Clients are backed up according to a policy that indicates a storage lifecycle
policy as the Policy storage selection.

At least one of the operations in the SLP must be configured for replication
to an OpenStorage (OST) appliance on a target master.

See “About the storage lifecycle policies required for Auto Image Replication
” on page 58.

Originating master
(Domain 1)

1

The OpenStorage storage server in the target domain recognizes that a
replication event has occurred and notifies the NetBackup master server in
that domain.

Target master (Domain 2)2

NetBackup imports the image immediately, based on an SLP that contains
an import operation. NetBackup can import the image quickly because the
metadata is replicated as part of the image. (This import process is not the
same as the import process available in the Catalog utility.)

Target master (Domain 2)3
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Table 2-3 Auto Image Replication process overview (continued)

Event descriptionDomain in which event
occurs

Event

After the image is imported into the target domain, NetBackup continues to
manage the copies in that domain. Depending on the configuration, the media
server in Domain 2 can replicate the images to a media server in Domain 3.

Target master (Domain 2)4

About the domain relationship
For OpenStorage and Auto Image Replication, the originating NetBackup domain
has no knowledge of the storage server in the target domain. The relationship
between the originating domain and the target domain is configured using the
disk appliance vendor's tools. When the appliances are configured properly,
NetBackup images on the originating disk appliance are replicated automatically
to the target disk appliance. That disk appliance uses the OpenStorage API to
notify NetBackup that a replication event occurred. NetBackup then imports those
images.

See “About the replication topology for Auto Image Replication” on page 45.

Caution: Choose the target storage server or servers carefully. A target storage
server must not also be a storage server for the originating domain.

One-to-many Auto Image Replication model
In this configuration, all copies are made in parallel. The copies are made within
the context of one NetBackup job and simultaneously within the originating
storage server context. If one target storage server fails, the entire job fails and
is retried later.

All copies have the same TargetRetention. To achieve different TargetRetention
settings in each target master server domain, either create multiple source copies
or cascade duplication to target master servers.

Cascading Auto Image Replication model
Replications can be cascaded from the originating domain to multiple domains.
To do so, storage lifecycle policies are set up in each domain to anticipate the
originating image, import it and then replicate it to the next target master.

Figure 2-2 represents the following cascading configuration across three domains.

■ The image is created in Domain 1, and then replicated to the target Domain
2.
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■ The image is imported in Domain 2, and then replicated to a target Domain 3.

■ The image is then imported into Domain 3.

Figure 2-2 Cascading Auto Image Replication

SLP (D1toD2toD3)
Import

Duplication to local storage

SLP (D1toD2toD3)
Backup

Replication to target master

SLP (D1toD2toD3)
Import

Replication to target server

All copies have the same
Target retention, as
indicated in Domain 1.

Import

Domain 1

Domain 2

Domain 3

Import

In the cascading model, the originating master server for Domain 2 and Domain
3 is the master server in Domain 1.

Note:When the image is replicated in Domain 3, the replication notification event
initially indicates that the master server in Domain 2 is the originating master
server. However, when the image is successfully imported into Domain 3, this
information is updated to correctly indicate that the originating master server is
in Domain 1.

The cascading model presents a special case for the Import SLP that will replicate
the imported copy to a target master. (This is the master server that is neither
the first nor the last in the string of target master servers.)

As discussed previously, the requirements for an Import SLP include at least one
operation that uses a Fixed retention type and at least one operation that uses a
Target Retention type. So that the Import SLP can satisfy these requirements,
the import operation must use a Target Retention.

Table 2-4 shows the difference in the import operation setup.
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Table 2-4 Import operation difference in an SLP configured to replicate the
imported copy

Import operation in a cascading modelImport operation criteria

Same; no difference.The first operation must be an import
operation.

Same; no difference.A replication to target master must use a
Fixed retention type

Here is the difference:

To meet the criteria, the import operation
must use Target retention.

At least one operation must use the Target
retention.

The target retention is embedded in the source image.

Because the imported copy is the copy being replicated to a target master server
domain, the fixed retention (three weeks in this example) on the replication to
target master operation is ignored. The target retention is used instead. (See
Figure 2-3.)

Figure 2-3 Storage lifecycle policy configured to replicate the imported copy

Target retention of source image

Replication goes to another domain

In the cascading model that is represented in Figure 2-2, all copies have the same
Target Retention—the Target Retention indicated in Domain 1.

For the copy in Domain 3 to have a different target retention, add an intermediary
replication operation to the Domain 2 storage lifecycle policy. The intermediary
replication operation acts as the source for the replication to target master. Since
the target retention is embedded in the source image, the copy in Domain 3 honors
the retention level that is set for the intermediary replication operation.
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Figure 2-4 Cascading replications to target master servers, with various target
retentions

Domain 3

SLP (D1toD2toD3)
Import

Duplication

Domain 2
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SLP (D1toD2toD3)
Backup

Replication to target master

The copy in Domain 3 has the
retention indicated by the
source replication in Domain 2.

SLP (D1toD2toD3)
Import

Duplication
Replication to target master

Import

Import

About OpenStorage optimized synthetic backups
One of the capabilities a vendor may expose is the disk appliance's potential to
construct synthetic backup images. A media server uses messages to instruct the
storage server which full and incremental backup images to use when creating
the synthetic backup. The storage server constructs (or synthesizes) the backup
image directly on the disk storage. In NetBackup, backups created in this way are
known as optimized synthetic backups.

The OpenStorage optimized synthetic backup method provides the following
benefits:

■ Faster than a synthetic backup.
Regular synthetic backups are constructed on the media server. They are
moved across the network from the storage server to the media server and
synthesized into one image. The synthetic image is then moved back to the
storage server.

■ Requires no data movement across the network.
Regular synthetic backups use network traffic.

■ Uses fewer disk resources, depending on the vendor implementation.
The storage vendor determines the storage implementation. If the disk
appliance uses data deduplication, duplicate data is not created and stored.
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In NetBackup, the Optimizedlmage attribute enables optimized synthetic backup.
It applies to both storage servers and disk pools.

If the original vendor plug-in exposed optimized synthetic backup functionality,
the storage server and disk pools inherited that functionality. However, if your
OpenStorage vendor updates their plug-in to add optimized synthetic backup
functionality, you have to update NetBackup.

See “Adding OpenStorage functionality to an existing environment” on page 73.

The following are the requirements for optimized synthetic backups:

■ The master and the media servers are at NetBackup version 6.5.4 or later.

■ The Enterprise Disk license key is installed on the NetBackup master server.

■ The plug-in from the disk appliance vendor supports the OpenStorage
OptimizedImage attribute.

■ The vendor plug-in is installed on each media server that connects to the
storage appliance.

■ The target storage unit's disk pool is the same disk pool on which the source
images reside.

About OpenStorage direct to tape
OpenStorage direct to tape lets you copy NetBackup backup images directly from
a disk appliance to tape. The copy operation does not use NetBackup media server
I/O.

NetBackup manages the copied images based on retention periods you define.

Direct to tape uses the Network Data Management Protocol (NDMP) for the copy
operations. Direct to tape requires specific NDMP features and release levels.

See “About NDMP requirements for OpenStorage direct to tape” on page 29.

NetBackup media servers manage the operations. The media servers require the
NetBackup for NDMP software and specific NetBackup release levels.

See “About media server requirements for OpenStorage direct to tape” on page 31.

How to configure OpenStorage direct to tape is described elsewhere.

See “Configuring OpenStorage direct to tape” on page 71.
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About NDMP requirements for OpenStorage direct to tape
If the NDMP requirements are not met, the images are still duplicated. However,
the copy operation uses the traditional duplication method of reading the image
through the NetBackup media server and writing out to tape.

Table 2-5 NDMP requirements for OpenStorage direct to tape

DescriptionNDMP functionality

The OpenStorage disk appliance requires an NDMP server that supports the OpenStorage
direct to tape specification. The Symantec OpenStorage Partner Program publishes the
specification. The direct to tape feature uses a subset of the NDMP File Service Extension
(FSE) commands.

The host that provides the NDMP FSE functionality can be one of the following entities:

■ The disk appliance storage server.

See “About OpenStorage storage servers for backups” on page 17.

■ An alternative name (that is, interface) for the storage server.

■ A separate host that interacts with the disk appliance. The host must be directly
connected to the disk appliance.

NDMP File Service
Extension

Direct to tape requires an NDMP tape server for the destination tape library. The NDMP
tape server must support NDMP v4 or later.

The host that provides the NDMP tape server functionality can be one of the following
entities:

■ The same host that provides the NDMP FSE functionality.

If one host provides the NDMP FSE and NDMP tape server functionality, the tape library
must be attached directly to that host. Data does not travel over the network.

See Figure 2-5 on page 30.

■ A host that is embedded in the tape library. Data travels over the network.

See Figure 2-6 on page 30.

■ A separate host to which the tape server is directly attached. Data travels over the
network.

See Figure 2-7 on page 30.

NDMP tape server

The NDMP FSE server must use the same credentials as the OpenStorage storage server.

If you use the NDMP FSE server for other purposes, do not configure the credentials
differently for that purpose. For example, if you also use the NDMP FSE server as a VTL
with NetBackup, use the same credentials when you configure it with NetBackup.

Credentials
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Figure 2-5 OpenStorage server provides all NDMP functionality

Tape library directly
attached to the
OpenStorage server

The disk appliance
provides both the NDMP
FSE and NDMP tape
server functionality

Network

Figure 2-6 Tape library with embedded NDMP tape server host

Tape library with embedded
NDMP tape server host

Network

The disk appliance provides
the NDMP FSE

Figure 2-7 Separate host provides NDMP tape server functionality

Tape library directly attached to
the NDMP host

The disk appliance
provides the NDMP FSE

Network
NDMP tape
server host

Planning your deployment
About OpenStorage direct to tape

30



About media server requirements for OpenStorage direct to tape
Although NetBackup media servers do not provide I/O, they are used to manage
the operations.

Table 2-6 Media server requirements for OpenStorage direct to tape

DescriptionMedia server function

In this context, the read side media server does not read or move the backup images.
It manages the read side of the NDMP copy operation.

The read side media server requires the following:

■ NetBackup 6.5.4 or later.

■ The NetBackup for NDMP software.

■ Logon credentials for the disk appliance storage server and the NDMP FSE host.

If the NDMP FSE host and the storage server host have the same name, NetBackup
uses the storage server credentials to logon to the NDMP host. Therefore, you do
not have to configure NDMP credentials in NetBackup. This NetBackup behavior
means that the credentials you create for the disk appliance storage server and the
NDMP FSE host must be the same.

If the NDMP FSE hostname is different than the storage server hostname, you must
configure logon credentials in NetBackup for that NDMP host.

Read side media server

In this context, the write side media server does not move or write the backup images.
It manages the write side of the NDMP copy operation.

The write side media server requires the following:

■ NetBackup 6.5 or later.

■ The NetBackup for NDMP software.

■ Logon credentials for the NDMP tape server host.

Write side media server

If one host provides both NDMP FSE and NDMP tape server functionality, one
media server functions as both the read and write server.

About media server recommendations for OpenStorage direct to tape
To simplify OpenStorage configuration and management, Symantec recommends
that you use one set of media servers for all OpenStorage activity. The media
servers then can function as either read or write side servers for direct to tape
operations. They also can function as data movers for other OpenStorage
operations.

For each media server in the set, do the following:

■ Configure logon credentials to the OpenStorage storage server.
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■ Install the NetBackup for NDMP software.

■ Configure logon credentials for the NDMP FSE host (if required).

■ Configure logon credentials for the NDMP tape server host.

See “About OpenStorage data movers for backups” on page 18.

About OpenStorage direct to tape limitations
The following limitations exist:

■ The destination storage unit must be NDMP. You cannot use a storage unit
group.

■ You cannot make multiple copies with one copy operation.

■ Backup images are not multiplexed when written to tape.

About the OpenStorage direct to tape process
The following is an overview of the direct copy to tape process:

■ NetBackup verifies that the image to be duplicated resides on an OpenStorage
device.

■ NetBackup verifies that the disk appliance NDMP host supports the
OpenStorage direct to tape specification.

■ NetBackup selects the write side media server, a destination tape drive, and a
tape volume.
NetBackup selects a media server that has credentials to the NDMP tape server
host. The media servers NetBackup considers are listed in the destination
storage unit.

The write side media server does the following:

■ Establishes an NDMP session with the NDMP tape server and confirms that
it supports the NDMP v4 protocol.

■ Mounts, opens, and positions the tape and then uses NDMP to write a header
to the tape.

■ Sets up the NDMP mover interface on the NDMP tape server. It also
monitors the progress of the write operation by waiting for any NDMP
notifications.

■ NetBackup selects the read side media server.
If the write side media server has credentials for the NDMP FSE host,
NetBackup selects it as the read side server. If it does not have credentials,
NetBackup selects a media server with credentials to the NDMP FSE host.
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The read side media server does the following:

■ Establishes an NDMP session with the NDMP FSE host.

■ Opens the files to be copied.

■ Sets up the NDMP mover interface on the NDMP FSE host. It also monitors
the progress of the read operation by waiting for any NDMP notifications.

■ By means of the NDMP protocol, the backup images on the disk appliance are
copied to the tape storage.

■ After the images are copied, the read and write media servers close their
connections to their respective NDMP hosts.

■ NetBackup validates the image copies; if valid, NetBackup ends the duplication
job with status 0 (success).
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Provisioning the storage

This chapter includes the following topics:

■ About provisioning the disk appliance storage

■ Installing the disk appliance plug-in

About provisioning the disk appliance storage
You or your storage administrator must install and configure the disk storage
appliance or appliances in your environment. The appliances must be operational
before you can use them for backups or duplication.

Specifically, do the following:

■ Install the appliances in your environment.

■ Install the vendor software packages on all NetBackup media servers that
connect to the appliances.
See “Installing the disk appliance plug-in” on page 36.

■ Perform vendor-specific steps to configure the appliances. Use the vendor’s
processes and procedures to configure the appliance so that it works with your
environment. To configure the storage, you may be required to do the following:

■ Assign the appliance a name. NetBackup uses the name to identify the
appliance.

■ Divide the appliance into one or more logical units of space. NetBackup
refers to these logical units as disk volumes. NetBackup aggregates the disk
volumes into disk pools.

■ Configure the replication properties of the appliance volumes.

How many appliances you provision depends on your storage requirements. It
also depends on whether or not you use optimized duplication or replication, as
follows:
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You must provision at least two appliances:

■ One appliance for the backups, which is the source for
the duplication operations.

■ Another appliance for the copies of the backup images,
which is the target for the duplication operations.

See “About optimized duplication within the same domain”
on page 21.

Optimized duplication within
the same NetBackup domain

You must provision at least two appliances:

■ One appliance for the backups in the originating domain.
This is the appliance on which NetBackup stores your
client backups. It is the source for the duplication
operations.

■ Another appliance in the remote domain for the copies
of the backup images. This appliance is the target for
the duplication operations that run in the originating
domain.

See “About NetBackup Auto Image Replication” on page 22.

Auto Image Replication to a
different NetBackup domain

Instructions for how to install and configure the appliance are beyond the scope
of the NetBackup documentation. For instructions, refer to the vendor
documentation.

Installing the disk appliance plug-in
If your storage is a disk appliance, the storage vendor’s release package includes
a plug-in to communicate with NetBackup. The plug-in installs on the NetBackup
media servers that connect to the storage server.

Table 3-1 To install the disk appliance plug-in

ProcedureTaskStep

See the vendor’s installation
instructions.

The vendor’s plug-in installation process
may also configure the storage server.

See “Configuring an OpenStorage
storage server for backups” on page 44.

Install the plug-in on all NetBackup
media servers that connect to the
appliance.

1

See theNetBackupAdministrator'sGuide
for your operating system.

Restart the NetBackup Remote Manager
and Monitor Service on each media
server on which you install the plug-in.

2
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After the installation of the plug-in, newly created storage servers and disk pools
inherit all of the functionality that the vendor exposes in their plug-in. However,
if the vendor updates the plug-in to add new functionality, you must update
existing storage servers and disk pools to use that new functionality.

See “Updating an OpenStorage storage server to reflect plug-in updates”
on page 78.

Vendor plug-ins must be 64-bit except for Windows Server 2008 R2, which may
be 32-bit.

See “Adding OpenStorage functionality to an existing environment” on page 73.
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Licensing OpenStorage

This chapter includes the following topics:

■ About the OpenStorage license key

■ Licensing OpenStorage

About the OpenStorage license key
OpenStorage is a feature that is licensed separately from base NetBackup. The
NetBackup OpenStorage Disk Option license activates OpenStorage.

The NetBackup OpenStorage Disk Option license also activates the NetBackup
for NDMP software, which is used for the direct to tape feature. You must install
the NetBackup for NDMP software on the media servers that you use for direct
to tape. You also must enter the license key on those media servers.

Enter the license key on the master server and on each media server that connects
to the disk appliance.

You may have a single license key that activates both NetBackup and the
OpenStorage Disk Option. Alternatively, you may have one license key that
activates NetBackup and another key that activates the OpenStorage Disk Option.

See “Licensing OpenStorage” on page 40.

The license key only enables the NetBackup functionality. You must purchase a
storage vendor’s product and install the storage vendor’s NetBackup plug-in.

If you remove the OpenStorage Disk Option license key or if it expires, the following
restrictions apply:

■ You cannot create the disk pools or the storage units that use the disk pools.

■ NetBackup jobs fail that attempt to use the disk pools or the storage units that
are based on the disk pools. The error message indicates that the feature is
not licensed.
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NetBackup does not delete the disk pools or the storage units that are based on
the disk pools. You can use them again if you enter a valid license key.

Licensing OpenStorage
No special installation is required for the NetBackup components of OpenStorage.
However, you must enter a license key.

The following procedure describes how to use the NetBackup Administration
Console to enter the license key.

Note: Enter the license key on the NetBackup master server and on each media
server that connects to the disk appliance. If you use the direct to tape feature,
also enter the license key on each NetBackup media server that you use for direct
to tape. Those media servers also must have the NetBackup for NDMP software
installed. The license key that activates OpenStorage also activates the NDMP
software on the media servers.

See “About OpenStorage direct to tape” on page 28.

To license OpenStorage

1 To add a license to a specific server, select File > Change Server and then
select the server.

2 In the NetBackup License Keys dialog box, click New.

3 In the AddaNewLicenseKey dialog box, enter the license key and click Add
or OK.

4 Click Close.

5 Restart all the NetBackup services and daemons.

Licensing OpenStorage
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Configuring OpenStorage
in NetBackup

This chapter includes the following topics:

■ Configuring OpenStorage disk appliance storage

■ Creating NetBackup log file directories

■ Configuring an OpenStorage storage server for backups

■ About the replication topology for Auto Image Replication

■ Viewing the replication topology for Auto Image Replication

■ Configuring an OpenStorage disk pool for backups

■ Configuring an OpenStorage storage unit

■ About the storage lifecycle policies required for Auto Image Replication

■ Creating a storage lifecycle policy

■ Creating a policy using the Policy Configuration Wizard

■ Creating a policy without using the Policy Configuration Wizard

■ Configuring OpenStorage optimized duplication behavior

■ Configuring OpenStorage optimized duplication within the same domain

■ Configuring OpenStorage direct to tape

■ Configuring OpenStorage optimized synthetic backups

■ Adding OpenStorage functionality to an existing environment
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■ Setting NetBackup configuration options by using bpsetconfig

Configuring OpenStorage disk appliance storage
Table 5-1 describes the tasks to configure NetBackup to use a third-party vendor's
disk appliance that conforms to the Symantec OpenStorage API.

The NetBackup administrator's guides describe how to configure a base NetBackup
environment.

See the NetBackup Administrator's Guide for Windows, Volume I.

See the NetBackup Administrator's Guide for UNIX and Linux, Volume I.

Table 5-1 OpenStorage disk appliance configuration tasks

InstructionsTaskStep

See “Planning your OpenStorage deployment” on page 15.Learn about planning your
deployment

Step 1

See “Creating NetBackup log file directories” on page 44.Enable legacy loggingStep 2

How many devices you provision depends on your storage requirements.
It also depends on whether or not you use optimized duplication or
replication.

See “About NetBackup Auto Image Replication” on page 22.

See “About provisioning the disk appliance storage” on page 35.

See “Installing the disk appliance plug-in” on page 36.

Provision the storage and
install the plug-in

Step 3

How many storage servers you configure depends on your storage
requirements. It also depends on whether or not you use optimized
duplication or replication.

See “About OpenStorage storage servers for backups” on page 17.

See “Configuring an OpenStorage storage server for backups” on page 44.

Configure one or more
storage servers

Step 4

How many disk pools you configure depends on your storage requirements.
It also depends on whether or not you use optimized duplication or
replication.

See “About the replication topology for Auto Image Replication” on page 45.

See “Viewing the replication topology for Auto Image Replication”
on page 46.

See “Configuring an OpenStorage disk pool for backups” on page 50.

Configure disk poolsStep 5

See “Configuring an OpenStorage storage unit” on page 51.Configure storage unitsStep 6

Configuring OpenStorage in NetBackup
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Table 5-1 OpenStorage disk appliance configuration tasks (continued)

InstructionsTaskStep

Optimized duplication is optional.

See “Configuring OpenStorage optimized duplication within the same
domain” on page 69.

See “Configuring OpenStorage optimized duplication behavior” on page 68.

Configure optimized
duplication

Step 7

Replication is optional.

To replicate images from one NetBackup domain to another, configure a
pair of storage lifecycle policies; one in each master server domain.

The storage lifecycle policy pair includes the following:

■ An SLP in the originating domain that contains a replication destination
to a target master. (The Auto Image Replication SLP.)

■ An SLP in the target domain that contains an import destination. (The
Import SLP.)

The following topic describes how the SLPs must be named and the storage
destinations and retention type that each SLP must contain.

See “About the storage lifecycle policies required for Auto Image Replication
” on page 58.

See “Creating a storage lifecycle policy” on page 62.

Configure a storage lifecycle
policy for replication

Step 8

To replicate images from one NetBackup domain to another, a backup policy
in the source domain must indicate the configured SLP as the Policystorage
selection.

See “Creating a policy using the Policy Configuration Wizard” on page 67.

See “Creating a policy without using the Policy Configuration Wizard”
on page 67.

Create a backup policyStep 9

Copy to tape is optional.

See “About OpenStorage direct to tape” on page 28.

See “Configuring OpenStorage direct to tape” on page 71.

Configure copy to tapeStep 10

Optimized synthetic backups are optional.

See “Configuring OpenStorage optimized synthetic backups” on page 73.

Configure optimized
synthetic backups

Step 11
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Creating NetBackup log file directories
Before you configure OpenStorage, create the directories into which NetBackup
commands write log files. Create the directories on the master server and on each
media server that you use for OpenStorage.

More information about NetBackup logging is available.

See the NetBackup Troubleshooting Guide.

See “About OpenStorage log files” on page 99.

To create log directories for NetBackup commands

◆ Depending on the operating system, run one of the following scripts:

UNIX: /usr/openv/netbackup/logs/mklogdir

Windows:install_path\NetBackup\logs\mklogdir.bat

To create the tpconfig command log directory

◆ Depending on the operating system, create the debug directory and the
tpcommand directory (by default, the debug directory and the tpcommand

directory do not exist). After you create the directories, the pathnames are
as follows:

UNIX: /usr/openv/volmgr/debug/tpcommand

Windows: install_path\Volmgr\debug\tpcommand

Configuring an OpenStorage storage server for
backups

Configure in this context means to add the storage host to NetBackup as a storage
server. When you configure a storage server, you also configure the media servers
that function as data movers.

If the storage host does not require logon credentials, you must enter dummy
credentials so that NetBackup configures the media servers as data movers.

To configure an OpenStorage storage server in NetBackup

1 In the NetBackupAdministrationConsole, in the left pane, click Mediaand
Device Management.

2 In the right pane, select Configure Disk Storage Servers.

3 Follow the wizard screens to configure a storage server.
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About the replication topology for Auto Image
Replication

The disk volumes of the devices that support Auto Image Replication have the
properties that define the replication relationships between the volumes. The
knowledge of the volume properties is considered the replication topology. The
following are the replication properties that a volume can have:

A source volume contains the backups of your clients. The volume is the
source for the images that are replicated to a remote NetBackup domain.
Each source volume in an originating domain has one or more replication
partner target volumes in a target domain.

Source

A target volume in the remote domain is the replication partner of a source
volume in the originating domain.

Target

The volume does not have a replication attribute.None

If your OpenStorage vendor's devices support replication, your storage
administrator configures the replication topology of the volumes in the storage
devices. Based on the volume properties, you create homogeneous disk pools. That
is, all of the volumes in a disk pool must have the same properties, and you create
the disk pools to match that topology. The disk pools inherit the replication
properties from the volumes that you add to them.

You should work with your storage administrator to understand the topology so
you can create the proper disk pools. You also should work with your storage
administrator to understand any changes that are made to the replication topology.

NetBackup discovers the topology of the volumes when you configure a disk pool.

NetBackup discovers topology changes when you use the Refresh option of the
Change Disk Pool dialog box.

See “Changing OpenStorage disk pool properties” on page 85.

NetBackup includes a command that can help you understand your replication
topology. Use the command in the following situations:

■ After you configure the storage server and before you configure disk pools.

■ After changes to the volumes that comprise the storage.

See “Viewing the replication topology for Auto Image Replication” on page 46.
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Viewing the replication topology for Auto Image
Replication

For a replication operation to succeed, a volume that is a source of replication
must have at least one replication partner that is the target of replication.
NetBackup lets you view the replication topology of the storage.

See “About the replication topology for Auto Image Replication” on page 45.

To view the replication topology for Auto Image Replication

◆ Run the bpstsinfo command, specifying the storage server name and the
server type. The following is the command syntax:

bpstsinfo -lsuinfo -storage_server storage_server_name -stype

server_type

The command is located in the following directory:

■ UNIX: /usr/openv/netbackup/bin/admincmd/

■ Windows: Install_path\NetBackup\bin\admincmd\

The following are the options and arguments for the command:

The name of the storage server.-storage_server storage_server_name

For an OpenStorage disk appliance, the
vendor provides the string for server_type.

-stype server_type

Save the output to a file so that you can compare the current topology with
the previous topology to determine what has changed.

Example output is available.

See “Sample volume properties output for OpenStorage backup replication”
on page 46.

Sample volume properties output for OpenStorage backup replication
The following examples show sample output from the bpstsinfo command for
two OpenStorage devices. The first example is the output from the source disk
pool that contains the client backups. The second example is from the target disk
pool in the remote master server domain.

The two examples show the following:

■ Volume dv01 on storage server pan1 is the replication source for volume dv01
on pan2.

Configuring OpenStorage in NetBackup
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■ Volume dv02 on storage server pan1 is the replication source for volume dv02
on pan2.

■ Volume dv03 on both devices has no replication properties.

>bpstsinfo -lsuinfo -storage_server pan1 -stype Pan

LSU Info:

Server Name: pan1

LSU Name: dv01

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_SOURCE)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 1 ( Pan:pan2:dv01 )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan1

LSU Name: dv02

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_SOURCE)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 1 ( Pan:pan2:dv02 )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008
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Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan1

LSU Name: dv03

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

>bpstsinfo -lsuinfo -storage_server pan2 -stype Pan

LSU Info:

Server Name: pan2

LSU Name: dv01

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_TARGET)

Save As : (STS_SA_IMAGE)

Replication Sources: 1 ( Pan:pan1:dv01 )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0
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LSU Info:

Server Name: pan2

LSU Name: dv02

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED | STS_LSUF_REP_ENABLED |

STS_LSUF_REP_TARGET)

Save As : (STS_SA_IMAGE)

Replication Sources: 1 ( Pan:pan1:dv02 )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0

LSU Info:

Server Name: pan2

LSU Name: dv03

Allocation : STS_LSU_AT_STATIC

Storage: STS_LSU_ST_NONE

Description: E:\

Configuration:

Media: (STS_LSUF_DISK | STS_LSUF_STORAGE_FREED)

Save As : (STS_SA_IMAGE)

Replication Sources: 0 ( )

Replication Targets: 0 ( )

Maximum Transfer: 2147483647

Block Size: 512

Allocation Size: 0

Size: 80525455360

Physical Size: 0

Bytes Used: 2285355008

Physical Bytes Used: 0

Resident Images: 0
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Configuring an OpenStorage disk pool for backups
When you create a disk pool, you specify the following:

■ The storage server.
For OpenStorage, the disk appliance is the storage server.

■ The disk volume or volumes to include in the pool.

■ The disk pool properties.
See “OpenStorage disk pool properties” on page 50.

Symantec recommends that disk volume and disk pool names be unique across
your enterprise.

See “Configuring an OpenStorage storage server for backups” on page 44.

To configure an OpenStorage disk pool

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management.

2 From the list of wizards in the right pane, click Configure Disk Pool and
follow the wizard instructions.

OpenStorage disk pool properties
The properties of an OpenStorage disk pool may vary depending on the purpose
the disk pool. The following table describes the possible properties:

Table 5-2 OpenStorage disk pool properties

DescriptionProperty

The disk pool name.Name

The storage server name.

For disk appliance storage, the storage server is the disk appliance host.

Storage server

Indicates that the disk pool is a source for replication.Replication source

Indicates that the disk pool is a target for replication.Replication target

For disk appliance storage, the disk volumes that comprise the disk pool.Disk volumes

The total amount of space available in the disk pool.Total size

The total raw, unformatted size of the storage in the disk pool.

The storage host may or may not expose the raw size of the storage.

Total raw size

Configuring OpenStorage in NetBackup
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Table 5-2 OpenStorage disk pool properties (continued)

DescriptionProperty

A comment that is associated with the disk pool.Comment

The High water mark setting is a threshold that triggers the following actions:

■ When an individual volume in the disk pool reaches the High water mark,
NetBackup considers the volume full. NetBackupchooses a different volume in
the disk pool to write backup images to.

■ When all volumes in the disk pool reach the High water mark, the disk pool is
considered full. NetBackup fails any backup jobs that are assigned to a storage
unit in which the disk pool is full. NetBackup also does not assign new jobs to a
storage unit in which the disk pool is full.

■ NetBackup begins image cleanup when a volume reaches the High water mark;
image cleanup expires the images that are no longer valid. For a disk pool that is
full, NetBackup again assigns jobs to the storage unit when image cleanup reduces
any disk volume's capacity to less than the High water mark.

The default is 98%.

High water mark

The Low water mark is a threshold at which NetBackup stops image cleanup.

TheLowwatermark setting cannot be greater than or equal to the Highwatermark
setting.

The default is 80%.

Low water mark

Select to limit the number of read and write streams (that is, jobs) for each volume
in the disk pool. A job may read backup images or write backup images. By default,
there is no limit.

When the limit is reached, NetBackup chooses another volume for write operations,
if available. If not available, NetBackup queues jobs until a volume is available.

Too many streams may degrade performance because of disk thrashing. Disk thrashing
is excessive swapping of data between RAM and a hard disk drive. Fewer streams can
improve throughput, which may increase the number of jobs that complete in a
specific time period.

Limit I/O streams

Select or enter the number of read and write streams to allow per volume.

Many factors affect the optimal number of streams. Factors include but are not limited
to disk speed, CPU speed, and the amount of memory.

per volume

Configuring an OpenStorage storage unit
Create one or more storage units that reference each disk pool that you configure.
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A storage unit inherits the properties of the disk pool. If the storage unit inherits
replication properties, the properties signal to a NetBackup storage lifecycle policy
the intended purpose of the storage unit and the disk pool. Auto Image Replication
requires storage lifecycle policies. Replication properties may not exist or be
exposed to NetBackup by the vendor plug-in.

See “About OpenStorage disk pools for backups” on page 19.

The Disk Pool Configuration Wizard lets you create a storage unit; therefore,
you may have created a storage unit when you created a disk pool. To determine
if storage units exist for the disk pool, see the NetBackupManagement>Storage
> Storage Units window of the NetBackup Administration Console.

See “About OpenStorage storage unit recommendations” on page 56.
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To create a storage unit from the Actions menu

1 In the NetBackupAdministrationConsole, in the left pane, select NetBackup
Management > Storage > Storage Units.

2 Click Actions > New > Storage Unit.

3 Complete the fields in the New Storage Unit dialog box.

4 Click OK.

OpenStorage storage unit properties
The configuration options for a OpenStorage disk pool storage unit are as follows:
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Table 5-3 OpenStorage storage unit properties

DescriptionProperty

Provide a unique name for the new storage unit. The name can describe the type of storage.
The storage unit name is the name used to specify a storage unit for policies and schedules.
The storage unit name cannot be changed after creation.

Storageunitname

Select Disk as the storage unit type.Storage unit type

Select OpenStorage (Solution) for the disk type. Solution is a string provided by the storage
vendor that may represent the vendor, the vendor device, or something else that is meaningful.

Disk type

Select Backup for the disk type.Disk pool
configured for

Indicates that the disk pool is a source for replication.

If you select this option, NetBackup filters the disk pools to show only those that contain
replication source volumes.

Replication
source

Indicates that the disk pool is a target for replication.

If you select this option, NetBackup filters the disk pools to show only those that contain
replication target volumes.

Replicationtarget

Select the disk pool that contains the storage for this storage unit.

If you select a replication property, NetBackup filters the disk pools that appear in the Disk
pool list. Otherwise, all disk pools of the specified Disk type appear If no disk pools are
configured, no disk pools appear in the list.

After you select a disk pool, you can click View Properties.

Disk pool
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Table 5-3 OpenStorage storage unit properties (continued)

DescriptionProperty

Specify the NetBackup media servers that can move data to the storage server for this storage
unit. (For OpenStorage, NetBackup media servers function as data movers.)

Only the media servers that are configured as data movers for the OpenStorage implementation
appear in the media server list. If a media server does not appear in the list, verify that the
software plug-in is installed and that logon credentials are created.

Specify the media server or servers as follows:

■ To allow any media server in the media server list to move data to the storage server, check
Use Any Available Media Server.

If you configure more media server data movers in the future, you do not have to update
the storage unit. After you install the plug-in and configure the credentials, NetBackup
automatically uses the media servers for the backups that are sent to the storage unit.

■ To restrict the media servers that can move data to the storage server, check Only Use The
FollowingMediaServers. Then select the media servers that are allowed to move the data.

Any media server in the list can receive data from the storage server; it does not have to be
selected. A media server receives data for restore jobs and for storage monitoring purposes.

NetBackup selects the media server to use when the policy runs.

Media server

Specify the largest fragment size that NetBackup can create to store backups.

The default maximum fragment size for a disk storage unit is 524,288 megabytes. To specify
a maximum fragment size other than the default, enter a value from 20 megabytes to 524,288
megabytes.

Backups to disk are usually fragmented to ensure that the backup does not exceed the maximum
size that the file system allows.

If an error occurs in a backup, the entire backup is discarded. The backup restarts from the
beginning, not from the fragment where the error occurred. (An exception is for backups for
which checkpoint and restart are enabled. In that case, fragments before and up to the last
checkpoint are retained; the fragments after the last checkpoint are discarded.)

Maximum
fragment size
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Table 5-3 OpenStorage storage unit properties (continued)

DescriptionProperty

Specify the maximum number of jobs that NetBackup can send to a disk storage unit at one
time. (Default: one job. The job count can range from 0 to 256.)

NetBackup queues jobs until the storage unit is available. If three backup jobs are ready to be
sent to the storage unit and Maximumconcurrent jobs is set to two, NetBackup starts the first
two jobs. NetBackup queues the third job. If a job contains multiple copies, each copy applies
toward the Maximum concurrent jobs count.

Maximumconcurrent jobs controls the traffic for backup and duplication jobs but not restore
jobs. The count applies to all servers in the storage unit, not per server. If you select multiple
media servers in the storage unit and 1 for Maximum concurrent jobs, only one job runs at a
time.

The number to enter depends on the available disk space and the server's ability to run multiple
backup processes.

Warning: A Maximum concurrent jobs setting of 0 disables the storage unit.

Maximum
concurrent jobs

About OpenStorage storage unit recommendations
You can use storage unit properties to control how NetBackup moves backup and
duplication data.

For example, you can accomplish the following objectives by using the storage
unit Media server setting:

■ Configure a favorable client-to-server ratio for important clients.
See “About configuring a favorable client-to-server ratio with OpenStorage”
on page 56.

■ Separate SAN client traffic from other traffic.
See “About separating OpenStorage SAN client traffic” on page 57.

You also can use the storage unit Maximum concurrent jobs setting to control
the backup or the duplication traffic that is sent to the media servers.

See “About throttling OpenStorage traffic to the media servers” on page 58.

About configuring a favorable client-to-server ratio with
OpenStorage
For a favorable client-to-server ratio, you can use one disk pool and configure
multiple storage units to separate your backup traffic. Because all storage units
use the same disk pool, you do not have to partition the storage.
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For example, assume that you have 100 important clients, 500 regular clients,
and four media servers. You can use two media servers to back up your most
important clients and two media servers to back up your regular clients.

The following example describes how to configure a favorable client-to-server
ratio:

■ Configure the media servers for OpenStorage and configure the storage.

■ Configure a disk pool.

■ Configure a storage unit for your most important clients (such as STU-GOLD).
Select the disk pool. Select Only use the following media servers. Select two
media servers to use for your important backups.

■ Configure a backup policy for the 100 important clients and select the
STU-GOLD storage unit. The media servers that are specified in the storage
unit move the client data to the storage server.

■ Configure another storage unit (such as STU-SILVER). Select the same disk
pool. Select Onlyuse the followingmedia servers. Select the other two media
servers.

■ Configure a backup policy for the 500 regular clients and select the STU-SILVER
storage unit. The media servers that are specified in the storage unit move the
client data to the storage server.

Backup traffic is routed to the wanted data movers by the storage unit settings.

Note: NetBackup uses storage units for media server selection for write activity
(backups and duplications) only. For restores, NetBackup chooses among all media
servers that have logon credentials to the storage server.

About separating OpenStorage SAN client traffic
If you use the NetBackup Fibre Transport option, you can use one disk pool and
multiple storage units to manage backup traffic. You can separate the NetBackup
SAN client traffic from the regular NetBackup client traffic. Because all storage
units use the same disk pool, you do not have to partition the storage.

The following example describes how to separate SAN client traffic:

■ Configure the FT media servers and the regular media servers for OpenStorage
and configure the storage.

■ Configure a disk pool.
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■ Define a storage unit (such as STU-FT). Select the disk pool. Select Only use
the following media servers. Select the FT media servers that connect to the
SAN clients.

■ Create a backup policy for the SAN clients and select the STU-FT storage unit.

■ Define another storage unit (such as STU-LAN). Select the same disk pool.
Select Only use the following media servers. Select the media servers with
LAN connectivity to the regular clients.

■ Create a backup policy for the regular clients and select the STU-LAN storage
unit.

Backup traffic is routed to the wanted data movers by the storage unit settings.

This scenario assumes that the SAN clients are a subset of your client base. It also
assumes that the media servers with LAN connectivity to the regular clients also
have SAN connectivity to the storage.

Note: NetBackup uses storage units for media server selection for write activity
(backups and duplications) only. For restores, NetBackup chooses among all media
servers that have logon credentials to the storage server.

About throttling OpenStorage traffic to the media servers
You can use the Maximumconcurrent jobs settings on disk pool storage units to
throttle the traffic to the media servers. Effectively, this setting also directs higher
loads to specific media servers when you use multiple storage units for the same
disk pool. A higher number of concurrent jobs means that the disk can be busier
than if the number is lower.

For example, two storage units use the same set of media servers. One of the
storage units (STU-GOLD) has a higher Maximum concurrent jobs setting than
the other (STU-SILVER). More client backups occur for the storage unit with the
higher Maximum concurrent jobs setting.

About the storage lifecycle policies required for Auto
Image Replication

To replicate images from the one NetBackup domain to another NetBackup domain
requires that two storage lifecycle policies be configured:

■ In the first (originating) NetBackup domain:
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One SLP that contains at least one Backup operation and one Replication
operation that is configured to replicate to a target NetBackup domain. (The
Auto Image Replication SLP.)

■ In the second, target NetBackup domain:
One SLP that contains an Import operation to import the replication. (The
Import SLP.) The Import SLP can be configured to create additional copies in
that domain or to cascade the copies to another domain.

Note: Both SLPs must have identical names.

Figure 5-1 shows how the SLP in the target domain is set up to replicate the images
from the originating master server domain.

Figure 5-1 Storage lifecycle policy pair required for Auto Image Replication

SLP on master server in the source domain

Import

Replication operation indicates
a target master

Import operation
imports copies

SLP that imports the copies to the target domain

Table 5-4 describes the requirements for each SLP in the pair.
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Table 5-4 SLP requirements for Auto Image Replication

Storage lifecycle policy requirementsDomain

The Auto Image Replication SLP must meet the following criteria:

■ The SLP must have the same name as the Import SLP in Domain 2.

■ The SLP must be of the same data classification as the Import SLP in Domain 2.

■ The Backup operation must be to an OpenStorage appliance. Indicate the exact storage unit
from the drop-down list. Do not select Any Available.

Note: The target domain must contain the same type of storage to import the image.

■ At least one operation must be a Replication operation with the Targetmaster option selected.

See Figure 5-2 on page 61.

Multiple Replication operations can be configured in an Auto Image Replication SLP. The master
server in Domain 1 does not know which target media server will be selected. If multiple SLPs
in target domains meet the criteria, NetBackup imports copies in all qualifying domains.

Domain 1

(Originating
domain)

The Import SLP must meet the following criteria:

■ The SLP must have the same name as the SLP in Domain 1 described above. The matching name
indicates to the SLP which images to process.

■ The SLP must be of the same data classification as the SLP in Domain 1 described above. Matching
the data classification keeps a consistent meaning to the classification and facilitates global
reporting by data classification.

■ The first operation in the SLP must be an Import operation.

Indicate the exact storage unit from the drop-down list. Do not select Any Available.

See Figure 5-3 on page 61.

■ The SLP must contain at least one Replication operation that has the Targetretention specified.

Domain 2

(Target
domain)

The following topic describes useful reporting information about Auto Image
Replication jobs and import jobs.

See “Reporting on Auto Image Replication jobs ” on page 96.
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Figure 5-2 Replication operation with Target master option selected in Domain
1 storage lifecycle policy

Figure 5-3 Import operation in Domain 2 storage lifecycle policy

See “Creating a storage lifecycle policy” on page 62.

Customizing how nbstserv runs duplication and import jobs
The NetBackup Storage Lifecycle Manager (nbstserv) runs replication, duplication,
and import jobs. Both the Duplication Manager service and the Import Manager
service run within nbstserv.

The NetBackup administrator can customize how nbstserv runs jobs by adding
parameters to the LIFECYCLE_PARAMETERS file.
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Creating a storage lifecycle policy
A storage lifecycle policy can be selected as the Policy storage within a backup
policy.

To create a storage lifecycle policy

1 In the NetBackupAdministrationConsole, select NetBackupManagement
> Storage > Storage Lifecycle Policies.

2 Click Actions > New > Storage Lifecycle Policy (UNIX) or Actions > New >
New Storage Lifecycle Policy (Windows).

3 In the New Storage Lifecycle Policy dialog box, enter a Storage lifecycle
policy name.

4 Select a Data classification. (Optional.)

5 Select the Priority for secondary operations. This number represents the
priority that jobs from secondary operations have in relationship to all other
jobs.

See “Storage Lifecycle Policy dialog box settings” on page 63.

6 Click Add to add operations to the SLP. The operations act as instructions
for the data.

See “Adding a storage operation to a storage lifecycle policy” on page 65.

7 Click OK to create the storage lifecycle policy.

Configuring OpenStorage in NetBackup
Creating a storage lifecycle policy

62



Storage Lifecycle Policy dialog box settings
A storage lifecycle policy consists of one or more operations.

The New Storage Lifecycle dialog box and the Change Storage Lifecycle Policy
dialog box contains the following settings.

Figure 5-4 Configuration tab of the Storage Lifecycle Policy dialog box

Table 5-5 Configuration tab of the Storage Lifecycle Policy dialog box

DescriptionSetting

The Storage lifecycle policy name describes the SLP. The name cannot be modified
after the SLP is created.

Storage lifecycle policy
name
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Table 5-5 Configuration tab of the Storage Lifecycle Policy dialog box
(continued)

DescriptionSetting

The Data classification defines the level of data that the SLP is allowed to process.
The Data classification drop-down menu contains all of the defined classifications.
The Data classification is an optional setting.

One data classification can be assigned to each SLP and applies to all operations in
the SLP. An SLP is not required to have a data classification.

If a data classification is selected, the SLP stores only those images from the policies
that are set up for that data classification. If no data classification is indicated, the
SLP accepts images of any classification or no classification.

The Data classification setting allows the NetBackup administrator to classify data
based on relative importance. A classification represents a set of backup requirements.
When data must meet different backup requirements, consider assigning different
classifications.

For example, email backup data can be assigned to the silver data classification and
financial data backup may be assigned to the platinum classification.

A backup policy associates backup data with a data classification. Policy data can be
stored only in an SLP with the same data classification.

Once data is backed up in an SLP, the data is managed according to the SLP
configuration. The SLP defines what happens to the data from the initial backup until
the last copy of the image has expired.

Data classification

The Priorityforsecondaryoperations setting is the priority that secondary jobs (for
example, duplication jobs), have in relationship to all other jobs. Range: 0 (default)
to 99999 (highest priority).

For example, the Priority for secondary operations for a policy with a gold data
classification may be set higher than for a policy with a silver data classification.

The priority of the backup job is set in the backup policy on the Attributes tab.

Priority for secondary
operations

The Operations list contains all of the operations in the SLP. Multiple operations
imply that multiple copies are created.

The list also contains the columns that display information about each operation.
Note that not all columns display by default.

For column descriptions, see the following topic:

Operations

Enable Suspend secondary operations to stop the operations in the SLP.

A selected SLP can also be suspended from the Actions menu and then activated
again (Activate).

Suspend secondary
operations
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Table 5-5 Configuration tab of the Storage Lifecycle Policy dialog box
(continued)

DescriptionSetting

Use this button to see how changes to this SLP can affect the policies that are
associated with this SLP. The button generates a report that displays on the Validation
Report tab.

This button performs the same validation as the -conflict option performs when
used with the nbstl command.

Validate Across Backup
Policies button

Use the arrows to indicate the indentation (or hierarchy) of the source for each copy.
One copy can be the source for many other copies.

Many operations can be hierarchical or non-hierarchical:

Arrows

Adding a storage operation to a storage lifecycle policy
Use the following procedure to add a storage operation to a storage lifecycle policy:

To add a storage operation to a lifecycle policy

1 In the NetBackupAdministrationConsole, select NetBackupManagement
> Storage > Storage Lifecycle Policies.

2 Click Actions > New > New Storage Lifecycle Policy (Windows) or Actions
> New > Storage Lifecycle Policy (UNIX).

3 Click Add to add operations to the SLP. The operations are the instructions
for the SLP to follow and apply to the data that is eventually specified in the
backup policy.

To create a hierarchical SLP, select an operation to become the source of the
next operation, then click Add.
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4 In the NewStorageOperation dialog box, select an Operation type. The name
of the operation reflects its purpose in the SLP:

■ Backup

■ Backup From Snapshot

■ Duplication
See “About NetBackup Auto Image Replication” on page 22.

■ Import

■ Index From Snapshot

■ Replication

■ Snapshot

5 Indicate where the operation is to write the image. Depending on the
operation, selections may include storage units or storage unit groups.

No BasicDisk, SnapVault, or disk staging storage units can be used as storage
unit selections in an SLP.

Note: In NetBackup 7.5, the Any_Available selection is not available for new
SLPs. In an upgrade situation, existing SLPs that use Any_Available continue
to work as they did before NetBackup 7.5. However, if the NetBackup
administrator edits an existing SLP, a specific storage unit or storage unit
group must be selected before the SLP can be saved successfully.

6 If the storage unit is a tape device or virtual tape library (VTL)., indicate the
Volume pool where the backups (or copies) are to be written.

7 Indicate the Media owner if the storage unit is a Media Manager type and
server groups are configured.

By specifying a Media owner, you allow only those media servers to write to
the media on which backup images for this policy are written.

8 Select the retention type for the operation:

■ Capacity managed

■ Expire after copy
If a policy is configured to back up to a lifecycle, the retention that is
indicated in the lifecycle is the value that is used. The Retention attribute
in the schedule is not used.

■ Fixed
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■ Maximum snapshot limit

■ Mirror

■ Target retention

9 Indicate an Alternate read server that is allowed to read a backup image
originally written by a different media server.

10 Click OK to create the storage operation.

Creating a policy using the Policy Configuration
Wizard

The easiest method to set up a backup policy is to use the Policy Configuration
Wizard. This wizard guides you through the setup process by automatically
choosing the best values for most configurations.

Not all policy configuration options are presented through the wizard. For example,
calendar-based scheduling and the Data Classification setting. After the policy
is created, modify the policy in the Policies utility to configure the options that
are not part of the wizard.

Use the following procedure to create a policy using the Policy Configuration
Wizard.

To create a policy with the Policy Configuration Wizard

1 In the NetBackupAdministrationConsole, in the left pane, click NetBackup
Management.

2 In the right pane, click Create a Policy to begin the Policy Configuration
Wizard.

3 Select File systems, databases, or applications.

4 Click Next to start the wizard and follow the prompts.

Click Help on any wizard panel for assistance while running the wizard.

Creating a policy without using the Policy
Configuration Wizard

Use the following procedure to create a policy without using the Policy
Configuration Wizard.
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To create a policy without the Policy Configuration Wizard

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Policies.

2 Type a unique name for the new policy in the Add a New Policy dialog box.

3 If necessary, clear the Use Policy Configuration Wizard checkbox.

4 Click OK.

5 Configure the attributes, the schedules, the clients, and the backup selections
for the new policy.

Configuring OpenStorage optimized duplication
behavior

You can configure the following optimized duplication behaviors:

By default, if an optimized duplication job fails, NetBackup does
not run the job again.

You can configure NetBackup to use normal duplication if an
optimized duplication fails.

See “To configure optimized duplication failover” on page 69.

Optimized duplication
failover

By default, NetBackup tries an optimized duplication job three
times before it fails the job.

You can change the number of times NetBackup retries an
optimized duplication job before it fails the jobs.

See “To configure the number of duplication attempts”
on page 69.

Number of optimized
duplication attempts

If a storage lifecycle policy optimized duplication job fails,
NetBackup waits two hours and then retries the job. By default,
NetBackup tries a job three times before the job fails.

You can change the number of hours for the wait period.

See “To configure the storage lifecycle policy wait period”
on page 69.

Storage lifecycle policy
retry wait period

Caution: These settings affect all optimized duplication jobs; they are not limited
to OpenStorage optimized duplication.

Configuring OpenStorage in NetBackup
Configuring OpenStorage optimized duplication behavior

68



To configure optimized duplication failover

◆ On the master server, add the following configuration option:

RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE

See “Setting NetBackup configuration options by using bpsetconfig”
on page 74.

Alternatively on UNIX systems, add the entry to the bp.conf file on the
NetBackup master server.

To configure the number of duplication attempts

◆ Create a file named OPT_DUP_BUSY_RETRY_LIMIT that contains an integer that
specifies the number of times to retry the job before NetBackup fails the job.

The file must reside on the master server in the following directory (depending
on the operating system):

■ UNIX: /usr/openv/netbackup/db/config

■ Windows: install_path\NetBackup\db\config.

To configure the storage lifecycle policy wait period

◆ Change the wait period for retries by adding an
IMAGE_EXTENDED_RETRY_PERIOD_IN_HOURS entry to the NetBackup
LIFECYCLE_PARAMETERS file. The default for this value is two hours.

For example, the following entry configures NetBackup to wait four hours
before NetBackup tries the job again:

IMAGE_EXTENDED_RETRY_PERIOD_IN_HOURS 4

The LIFECYCLE_PARAMETERS file resides in the following directories:

■ UNIX: /usr/openv/netbackup/db/config

■ Windows: install_path\NetBackup\db\config.

Configuring OpenStorage optimized duplication
within the same domain

You can configure optimized duplication from one disk appliance to another.

A NetBackup media server initiates and manages the duplication between
appliances. After the duplication completes, the media server connects to the
destination appliance to verify the image copy. NetBackup maintains records of
the image copies and their locations in the NetBackup catalog.

See “About optimized duplication within the same domain” on page 21.
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To configure optimized duplication

1 Ensure that all requirements are met.

See “About optimized duplication within the same domain” on page 21.

2 Configure optimized duplication behaviors.

See “Configuring OpenStorage optimized duplication behavior” on page 68.

See “About throttling OpenStorage traffic to the media servers” on page 58.

3 Select the media server in common.

In the storage unit for the destination disk pool, select Onlyusethefollowing
media servers. Then, select the media server or media servers that are
common to both the source storage server and the destination storage server.

If you select more than one, NetBackup balances the optimized copy job load
among them.

4 Use one of the following methods to duplicate backup images:

■ A storage lifecycle policy. The storage lifecycle policy manages both the
backup jobs and the duplication jobs.

When you configure the storage lifecycle policy, do the following:

■ For the Backup destination, select the Storage unit that is the target
of your backups.
The disk appliance for the storage unit contains the primary backup
copies; they are the source images for the duplication operation.

■ For the Duplication destination, select the Storage unit for the disk
pool on another appliance.

See “Creating a storage lifecycle policy” on page 62.

■ A Vault policy. For Vault, you must configure a Vault profile and a Vault
policy.

■ On the Vault Profile dialog box ChooseBackups tab, choose the backup
images in the source disk pool.

■ On the Vault Profile dialog box Duplication tab, select the destination
storage unit in the Destination Storage unit field.

■ Configure a Vault policy to schedule the duplication jobs. A Vault policy
is a NetBackup policy that is configured to run Vault jobs. Select the
profile you created for the OpenStorage duplication job.

See the NetBackup Vault Administrator’s Guide.

■ The bpduplicate command. Use the NetBackup bpduplicate command
to copy images manually.
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Duplicate from the source storage to the destination storage.
See NetBackup Commands Reference Guide.

You can apply separate retention periods to each copy. For example, you can
retain the source image for three weeks and the destination copy for a longer
period of time. If you delete the source image, the copy is not deleted.

Configuring OpenStorage direct to tape
To configure OpenStorage direct to tape, you must perform multiple procedures
on multiple computers. These procedures are in addition to the procedures to
install and configure the disk appliance and OpenStorage.

See “About OpenStorage direct to tape” on page 28.

Table 5-6 OpenStorage direct to tape configuration overview

DescriptionActionStep

See the NetBackup for NDMP Administrator’s Guide.Install and configure the
NDMP tape server hosts and
storage devices

Step 1

If you upgraded a disk appliance so it supports the Symantec OpenStorage
copy to tape specification, you must reconfigure the storage server in
NetBackup.

See “Configuring an OpenStorage storage server for backups” on page 44.

Reconfigure the storage
server

Step 2

Install the NetBackup for NDMP software on each media server you use
for direct to tape.

See “About media server requirements for OpenStorage direct to tape”
on page 31.

See “About media server recommendations for OpenStorage direct to tape”
on page 31.

See the NetBackup for NDMP Administrator’s Guide.

You must enter a license key that activates NDMP on those media servers.
The license key that activates OpenStorage also activates NetBackup for
NDMP.

Install the NetBackup for
NDMP software

Step 3

Configure logon credentials in NetBackup for the NDMP hosts.

See “About NDMP requirements for OpenStorage direct to tape” on page 29.

See the NetBackup for NDMP Administrator’s Guide.

Configure NDMP host
credentials

Step 4
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Table 5-6 OpenStorage direct to tape configuration overview (continued)

DescriptionActionStep

The storage units must be configured as NDMP storage units, and they
must use the NDMP tape storage as their destination.

You do not have to include the write side media servers explicitly in the
storage unit. If you configure AnyAvailable, when the job runs NetBackup
selects a media server that has the logon credentials for the NDMP tape
server.

See theNetBackup Administrator's Guide for UNIX and Linux, Volume I or
the NetBackup Administrator's Guide for Windows, Volume I.

Configure the NetBackup
storage units

Step 5

First ensure that all requirements are met.

See “About NDMP requirements for OpenStorage direct to tape” on page 29.

Then, use one of the following methods for direct to tape:

■ Create a storage lifecycle policy to create the backup and to duplicate
the backup images automatically.

For the Backup destination Storageunit, select the storage unit for the
disk pool on one appliance. For the Duplication destination Storage
unit, select the NDMP storage unit.

See the NetBackup Administrator’s Guide for UNIX and Linux, Volume
I or the NetBackup Administrator's Guide for Windows, Volume I.

■ Create a Vault policy to copy images automatically.

On the Profile dialog box ChooseBackups tab, choose the backup images
in the source disk pool on one appliance. For the Destination Storage
unit on the Duplication tab, select the NDMP storage unit.

See the NetBackup Vault Administrator’s Guide.

■ Use the Duplicate option in the Catalog node of the NetBackup
Administration Console.

Select the NDMP storage unit as the destination for the duplication.
Use the Storage unit field in the Setup Duplication Variables dialog
box.

See the NetBackup Administrator’s Guide for UNIX and Linux, Volume
I or the NetBackup Administrator's Guide for Windows, Volume I.

■ Use the NetBackupbpduplicate command to duplicate images on the
disk appliance to an NDMP storage unit.

See NetBackup Commands Reference Guide..

Configure the copy to tape
process

Step 6
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Configuring OpenStorage optimized synthetic
backups

Use the following procedure to configure optimized synthetic backups.

If NetBackup cannot produce the optimized synthetic backup, NetBackup creates
the more data-movement intensive synthetic backup.

See “About OpenStorage optimized synthetic backups” on page 27.

To configure optimized synthetic backup

1 Configure a Standard or MS-Windows backup policy.

2 Select the Synthetic backup attribute on the Schedule Attribute tab.

Adding OpenStorage functionality to an existing
environment

Your OpenStorage vendor may update their plug-in to expose more functionality
on their disk appliance. For example, the vendor may update their plug-in to
support optimized synthetic backups.

If the vendor provides an updated plug-in, you must complete the following
procedures to integrate the new functionality into NetBackup.

Table 5-7 Overview of how to add OpenStorage functionality

ProcedureTask

See “Installing the disk appliance plug-in” on page 36.Install the updated plug-in

You must update the storage server so NetBackup can use the
new functionality.

See “Updating an OpenStorage storage server to reflect plug-in
updates” on page 78.

Update the storage server

You also must update existing disk pools so they recognize
the new functionality.

See “Updating an OpenStorage disk pool to reflect plug-in
updates” on page 93.

Any disk pools that you create after you update the vendor
plug-in and storage server inherit the new functionality.

Update existing disk pools
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Setting NetBackup configuration options by using
bpsetconfig

Symantec recommends that you use the NetBackup Administration Console
Host Properties to configure NetBackup.

However, some configuration options cannot be set by using the Administration
Console. You can set those configuration options by using the bpsetconfig

command. Configuration options are key and value pairs, as shown in the following
examples:

■ SERVER = server1.symantecs.org

■ CLIENT_READ_TIMEOUT = 300

■ RESUME_ORIG_DUP_ON_OPT_DUP_FAIL = TRUE

Alternatively, on UNIX systems you can set configuration options in the bp.conf
file.

See the NetBackup Administrator's Guide for UNIX and Linux, Volume I.

To set configuration options by using the bpsetconfig command

1 On the host on which you want to set configuration options, invoke the
bpsetconfig command, as follows:

UNIX: /usr/openv/netbackup/bin/admincmd/bpsetconfig

Windows: install_path\NetBackup\bin\admincmd\bpsetconfig

2 At the bpsetconfig prompt, enter the key and the value pairs of the
configuration options that you want to set, one pair per line.

Ensure that you understand the values that are allowed and the format of
any new options that you add.

You can change existing key and value pairs.

You can add key and value pairs.

3 To save the configuration changes, type the following, depending on the
operating system:

UNIX: Ctrl + D Enter

Windows: Ctrl + Z Enter
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Managing OpenStorage

This chapter includes the following topics:

■ Managing OpenStorage storage servers

■ Managing OpenStorage server credentials

■ Managing OpenStorage data movers

■ Managing OpenStorage disk pools

■ Monitoring OpenStorage storage capacity and usage

■ Viewing OpenStorage disk reports

■ Reporting on Auto Image Replication jobs

■ About catalog backups to OpenStorage devices

■ About restoring from backup copies

■ About restoring from a backup at a target master domain

Managing OpenStorage storage servers
After you configure OpenStorage, you can perform various tasks to manage storage
servers.

See “Changing OpenStorage storage server properties” on page 76.

See “Deleting an OpenStorage storage server” on page 76.

See “Determining OpenStorage storage server state” on page 77.

See “Removing OpenStorage storage server attributes” on page 78.

See “Setting OpenStorage storage server attributes” on page 77.
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See “Updating an OpenStorage storage server to reflect plug-in updates”
on page 78.

See “Viewing OpenStorage storage servers” on page 79.

Changing OpenStorage storage server properties
You can change the OpenStorage storage server properties. The storage vendor
exposes the properties that you can change.

See “About OpenStorage storage servers for backups” on page 17.

To change deduplication storage server properties

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Server

2 Select the storage server.

3 On the Edit menu, select Change.

4 In the Change Storage Server dialog box, select the Properties tab.

5 To change a value, select it in the Value column and then change the value.

6 When finished changing values, click OK.

7 Click OK.

Deleting an OpenStorage storage server
If you delete a storage server, NetBackup removes it from your configuration.

Warning: Do not delete a storage server if the storage that it manages contains
unexpired NetBackup images.

To delete an OpenStorage storage server

1 If the storage server currently manages volumes, perform the following tasks:

■ Expire the the images on the volumes.

Warning: If unexpired images are deleted, data loss may occur.

■ Delete the storage units that comprise the disk pools.
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■ Delete the disk pools.

2 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Credentials > Storage Servers

3 Select the storage server that you want to delete.

4 On the Edit menu, select Delete.

5 Click Yes in the confirmation dialog box.

Determining OpenStorage storage server state
Use the NetBackupnbdevquery command to determine the state of an OpenStorage
storage server.

To determine OpenStorage storage server status

◆ Run the following command:

nbdevquery -liststs -stype server_type -storage_server server_name

-U

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the
server type.

The State field shows either UP or DOWN.

Setting OpenStorage storage server attributes
You may have to set or clear attributes on your storage server. Usually, you set
attributes to add or remove functionality.

If you set attributes on the storage server, you also must set the same attributes
on the existing disk pools. Any disk pools that you create after you set attributes
on the storage server inherit the new functionality.

To set an OpenStorage storage server attribute

◆ Run the following command on the NetBackup master server or on a storage
server:

nbdevconfig -changests -storage_server hostname -stype server_type

-setattribute attribute
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For hostname, use the name of the disk appliance host. For server_type, the
OpenStorage vendor provides the string that identifies their storage type.
For attribute, use the name of the attribute you want to set.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

Removing OpenStorage storage server attributes
You may have to remove attributes from your storage server. Usually, you remove
attributes to change or remove functionality.

If you remove attributes on the storage server, you also must remove the same
attributes on the existing disk pools. Any disk pools that you create after you
update the storage server inherit the storage server functionality.

To remove an OpenStorage storage server attribute

◆ Run the following command on the NetBackup master server or on a storage
server:

nbdevconfig -changests -storage_server hostname -stype server_type

-clearattribute attribute

For hostname, use the name of the disk appliance host. For server_type, the
OpenStorage vendor provides the string that identifies their storage type.
For attribute, use the name of the attribute you want to clear.

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

Updating an OpenStorage storage server to reflect plug-in updates
If an OpenStorage partner updates their plug-in, update the NetBackup storage
server to reflect the new functionality of the plug-in.

After you update the storage server, also update any existing disk pools.

See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 93.
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To update an OpenStorage storage server from the NetBackup Administration
Console

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Servers.

2 In the right pane, right-click the storage server.

3 Select Update Storage Server Details.

4 Update the existing disk pools so that each can use the new functionality.
Any disk pools that were created after the storage server is updated inherit
the new functionality.

To update an OpenStorage storage server from the command line

1 Run the following command on the master server or on one of the media
servers:

nbdevconfig -updatests -storage_server storage_server

-stypeserver_type -media_server media_server

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

See the following descriptions of the options that require arguments:

The name of the disk appliance.-storage_server

storage_server

The storage vendor provides the string that identifies the
server type.

-stype server_type

A NetBackup media server that connects to the storage
server. The media server queries the storage server for its
capabilities. The vendor plug-in must be installed on the
media server. If the plug-in resides on more than one media
server, you can specify any one of them.

-media_server

media_server

2 Update the existing disk pools so that each can use the new functionality.
Any disk pools that were created after the storage server is updated inherit
the new functionality.

Viewing OpenStorage storage servers
Use the NetBackup Administration Console to view a list of storage servers already
configured.
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To view OpenStorage storage servers

◆ In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Credentials > Storage Server.

The right All Storage Servers pane shows all configured storage servers.
OpenStorage storage servers show the vendor string that identifies the storage
type in the Disk Type column.

Managing OpenStorage server credentials
You can perform various tasks to manage existing credentials in NetBackup.

See “Adding OpenStorage server credentials” on page 80.

See “Changing OpenStorage server credentials” on page 80.

See “Deleting the OpenStorage server credentials of a data mover” on page 81.

See “Determining if OpenStorage server credentials exist” on page 81.

Adding OpenStorage server credentials
You can add a media server as a data mover to your OpenStorage configuration.
If you do, you must add the storage server credentials to that media server.

See “Adding an OpenStorage data mover” on page 82.

To add OpenStorage server credentials

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Servers.

2 Select the storage server, then select Edit > Change.

3 Select the Media Servers tab.

4 Select the server you want to add. Also ensure that any servers already
credentialed are selected.

5 Enter the credentials.

6 Click Set and then click OK.

Changing OpenStorage server credentials
You can change the credentials that the media servers that function as data movers
use. The credentials are for the storage server.

See “About OpenStorage server credentials” on page 17.
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To change OpenStorage server credentials

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Server.

2 Select the storage server, then select Edit > Change.

3 Select the Media Servers tab.

4 Select the media servers that function as data movers.

5 Change the credentials.

6 Click Set and then click OK.

Deleting the OpenStorage server credentials of a data mover
If you remove a media server as a data mover, you must delete the storage server
credentials of the media server.

If the host failed and is unavailable, you can use the tpconfigdevice configuration
utility in menu mode to delete the credentials. However, you must run thetpconfig
utility on a UNIX or Linux NetBackup server.

For procedures, see the NetBackup Administrator’s Guide for UNIX and Linux,
Volume II.

To delete OpenStorage server credentials of a data mover

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Server.

2 Select the storage server, then select Edit > Change.

3 Select the Media Servers tab.

4 Select the media server for which you want to delete the credentials.

5 Click Remove and then click OK.

Determining if OpenStorage server credentials exist
You can determine which media servers have credentials configured for the atorage
server.
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To determine if the storage server credentials are configured already

1 In the NetBackup Administration Console, expand Media and Device
Management > Credentials > Storage Server.

2 Select the storage server, then select Edit > Change.

3 Select the Media Servers tab.

The media servers for which credentials are configured are identified in the
Media Servers Status column.

Managing OpenStorage data movers
In OpenStorage, NetBackup media servers function as the data movers. A data
mover is an entity that moves data between the primary storage (the NetBackup
client) and the storage server.

For an existing OpenStorage environment in NetBackup, you can do the following:

■ Add a media server as a data mover.
See “Adding an OpenStorage data mover” on page 82.
To add an OpenStorage data mover, see the procedure later in this section.

■ Retire a media server as a data mover.
See “Retiring an OpenStorage data mover” on page 83.

See “About OpenStorage data movers for backups” on page 18.

Adding an OpenStorage data mover
Use the following process to add an OpenStorage data mover.

Table 6-1 Process to add an OpenStorage data mover

DescriptionTaskStep

See the NetBackup Installation Guide for UNIX and
Linux or the NetBackup Installation Guide for
Windows.

Install and configure the NetBackup media server
software.

Step 1

See “Installing the disk appliance plug-in”
on page 36.

For disk appliance storage, install the OpenStorage
vendor software plug-in on the media server

Step 2

Beyond the scope of the NetBackup documentation.For disk appliance storage, connect the NetBackup
media server to the OpenStorage appliance.

Step 3

See “Adding OpenStorage server credentials”
on page 80.

Add the storage server logon credentials for the
media server.

Step 4
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Table 6-1 Process to add an OpenStorage data mover (continued)

DescriptionTaskStep

In the NetBackup Administration Console, in the
left pane, select NetBackupManagement>Storage
> Storage Units.

For every storage unit that points to a disk pool of
that storage server, verify that the new media server
appears. The storage unit dialog box includes a
media servers list.

For every storage unit that is configured to use any
available media server, the new data mover is
allowed access to the storage server automatically.

Step 5

In the NetBackup Administration Console, in the
left pane, select NetBackupManagement>Storage
> Storage Units.

For every storage unit that specifies Use one of the
followingmediaservers, update the storage unit so
it uses the correct data movers.

This step is not required if the storage unit is
configured to use any available media server.

Step 6

Retiring an OpenStorage data mover
Use the following process to retire an OpenStorage data mover.

Table 6-2 Process to retire an OpenStorage data mover

WhereWhat

See the NetBackup Installation Guide for
UNIX and Linux or the NetBackup
Installation Guide for Windows.

For every NetBackup storage unit that
specifies that data mover (that is, media
server), clear the checkbox that specifies the
media server.

This step is not required if the storage unit
is configured to use any available media
server.

See “Deleting the OpenStorage server
credentials of a data mover” on page 81.

On the media server to be retired, delete the
credentials for the storage server.

Managing OpenStorage disk pools
After you configure OpenStorage, you can perform various tasks to manage your
OpenStorage disk pools.

See “Adding volumes to an OpenStorage disk pool” on page 84.

See “Changing OpenStorage disk pool properties” on page 85.
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See “Changing OpenStorage disk pool state” on page 89.

See “Changing OpenStorage disk volume state” on page 90.

See “Deleting an OpenStorage disk pool” on page 90.

See “Determining OpenStorage disk pool state” on page 91.

See “Determining OpenStorage disk volume state” on page 91.

See “Merging OpenStorage disk pools” on page 92.

See “Removing a volume from an OpenStorage disk pool” on page 93.

See “Updating an OpenStorage disk pool to reflect plug-in updates” on page 93.

See “Viewing OpenStorage disk pools” on page 94.

Adding volumes to an OpenStorage disk pool
If you add disk volumes to the storage appliance, NetBackup does not add those
volumes to an OpenStorage disk pool automatically. To use the additional disk
volumes in an existing disk pool, you must add those volumes to the disk pool.

(By default, NetBackup automatically increases disk pool capacity if the capacity
of the underlying disk volumes increases. Similarly, NetBackup decreases the
capacity of a disk pool if the underlying disk volume capacity decreases.)

The NetBackup storage units that use the disk pool automatically use the additional
storage capacity. You do not have to change the storage units.

You also can add volumes by using the Change Disk Pool dialog box.

See “Changing OpenStorage disk pool properties” on page 85.

Table 6-3 Add volumes process for OpenStorage disk pool

ProcedureTask

See “Configuring an OpenStorage disk pool
for backups” on page 50.

Configure a disk pool from the new disk
volumes on the storage server.

See “Merging OpenStorage disk pools”
on page 92.

Merge the disk pools.

When you merge the disk pools, specify the
original disk pool as the primary one.
NetBackup deletes the secondary disk pool
after the merge.
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Changing OpenStorage disk pool properties
You can change the properties of a disk pool and manage the topology of existing
volumes that have replication properties. If NetBackup discovers new volumes
that match the replication properties of the disk pool, you can add those volumes.

Another method exists to add volumes to a disk pool.

See “Adding volumes to an OpenStorage disk pool” on page 84.

To change OpenStorage disk pool properties

1 In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Devices > Disk Pools.

2 In the right pane, select the disk pool you want to change.

3 Click Edit > Change.

85Managing OpenStorage
Managing OpenStorage disk pools



4 To query the storage server for disk volume changes, click Refresh in the
Change Disk Pool dialog box.

If NetBackup discovers changes, your actions depend on the changes
discovered.

See “How to resolve volume changes for Auto Image Replication” on page 86.

5 Change the other properties as necessary.

See “OpenStorage disk pool properties” on page 50.

6 Click OK.

How to resolve volume changes for Auto Image Replication
When you open the Change Disk Pool dialog box, NetBackup loads the disk pool
properties from the catalog. NetBackup only queries the storage server for changes
when you click the Refresh in the Change Disk Pool dialog box.

Symantec recommends that you take the following actions when the volume
topology change:

■ Discuss the changes with the storage administrator. You need to understand
the changes so you can change your disk pools (if required) so that NetBackup
can continue to use them.

■ If the changes were not planned for NetBackup, request that the changes be
reverted so that NetBackup functions correctly again.

NetBackup can process changes to the following volume properties:

■ Replication Source

■ Replication Target

■ None

If these volume properties change, NetBackup can update the disk pool to match
the changes. NetBackup can continue to use the disk pool, although the disk pool
may no longer match the storage unit or storage lifecycle purpose.

Table 6-4 describes the possible outcomes and describes how to resolve them.

Table 6-4 Refresh outcomes

DescriptionOutcome

No changes are required.No changes are discovered.

The new volumes appear in the Change Disk Pool dialog box. Text in the dialog box
changes to indicate that you can add the new volumes to the disk pool.

NetBackup discovers the new
volumes that you can add to the
disk pool.
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Table 6-4 Refresh outcomes (continued)

DescriptionOutcome

A Disk Pool Configuration Alert pop-up box notifies you that the properties of all of
the volumes in the disk pool changed, but they are all the same (homogeneous).

You must click OK in the alert box, after which the disk pool properties in the Change
Disk Pool dialog box are updated to match the new volume properties.

If new volumes are available that match the new properties, NetBackup displays those
volumes in the Change Disk Pool dialog box. You can add those new volumes to the
disk pool.

In the Change Disk Pool dialog box, select one of the following two choices:

■ OK. To accept the disk pool changes, click OK in the Change Disk Pool dialog box.
NetBackup saves the new properties of the disk pool.

NetBackup can use the disk pool, but it may no longer match the intended purpose
of the storage unit or storage lifecycle policy. Change the storage lifecycle policy
definitions to ensure that the replication operations use the correct source and
target disk pools, storage units, and storage unit groups. Alternatively, work with
your storage administrator to change the volume properties back to their original
values.

■ Cancel. To discard the changes, click Cancel in the Change Disk Pool dialog box.
NetBackup does not save the new disk pool properties. NetBackup can use the disk
pool, but it may no longer match the intended use of the storage unit or storage
lifecycle policy.

The replication properties of all
of the volumes changed, but they
are still consistent.
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Table 6-4 Refresh outcomes (continued)

DescriptionOutcome

A DiskPoolConfigurationError pop-up box notifies you that the replication properties
of some of the volumes in the disk pool changed. The properties of the volumes in the
disk pool are not homogeneous.

You must click OK in the alert box.

In the ChangeDiskPool dialog box, the properties of the disk pool are unchanged, and
you cannot select them (that is, they are dimmed). However, the properties of the
individual volumes are updated.

Because the volume properties are not homogeneous, NetBackup cannot use the disk
pool until the storage configuration is fixed.

NetBackup does not display new volumes (if available) because the volumes already in
the disk pool are not homogeneous.

To determine what has changed, compare the disk pool properties to the volume
properties.

See “Viewing the replication topology for Auto Image Replication” on page 46.

Work with your storage administrator to change the volume properties back to their
original values.

The disk pool remains unusable until the properties of the volumes in the disk pool are
homogenous.

In the Change Disk Pool dialog box, click OK or Cancel to exit the Change Disk Pool
dialog box.

The replication properties of the
volumes changed, and they are
now inconsistent.
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Table 6-4 Refresh outcomes (continued)

DescriptionOutcome

A Disk Pool Configuration Alert pop-up box notifies you that an existing volume or
volumes was deleted from the storage device:

NetBackup can use the disk pool, but data may be lost.

To protect against accidental data loss, NetBackup does not allow volumes to be deleted
from a disk pool.

To continue to use the disk pool, do the following:

■ Use the bpimmedia command or the Images on Disk report to display the images
on the specific volume.

■ Expire the images on the volume.

■ Use the nbdevconfig command to set the volume state to DOWN so NetBackup
does not try to use it.

NetBackup cannot find a volume
or volumes that were in the disk
pool.

Changing OpenStorage disk pool state
Disk pool state is UP or DOWN.

To change the state to DOWN, the disk pool must not be busy. If backup jobs are
assigned to the disk pool, the state change fails. Cancel the backup jobs or wait
until the jobs complete.

To change OpenStorage disk pool state

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Device Monitor.

2 At the bottom of the right pane, select the Disk Pools tab.

3 Select the disk pool.

4 Select either Actions > Up or Actions > Down.

89Managing OpenStorage
Managing OpenStorage disk pools



Changing OpenStorage disk volume state
Use the NetBackup nbdevconfig command to change disk volume state. The state
is UP or DOWN.

To change the state to DOWN, the disk pool in which the volume resides must not
be busy. If backup jobs are assigned to the disk pool, the state change fails. Cancel
the backup jobs or wait until the jobs complete.

NetBackup jobs still read from and write to a disk pool that has a downed volume,
but the downed volume is unavailable.

To change OpenStorage disk volume state

1 Determine the name of the disk volume. The following command lists all
volumes in the specified disk pool:

nbdevquery -listdv -stype server_type -dp disk_pool_name

The following is the path to the nbdevquery command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the
server type.

2 Change the disk volume state using the following command syntax:

nbdevconfig -changestate -stype server_type -dp disk_pool_name

–dv vol_name -state state

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the
server type.

The state is either UP or DOWN.

Deleting an OpenStorage disk pool
If you delete a disk pool, NetBackup removes it from your configuration.

If a disk pool is the storage destination of a storage unit, you must first delete the
storage unit.
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Warning: Do not delete a disk pool that contains unexpired NetBackup images; if
you do, data loss may occur.

To delete an OpenStorage disk pool

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Devices > Disk Pools.

2 Select a disk pool.

3 Click Edit > Delete.

4 In the Delete Disk Pool dialog box, verify that the disk pool is the one you
want to delete and then click OK.

Determining OpenStorage disk pool state
Disk pool state is UP or DOWN.

To determine OpenStorage disk pool state

1 In the NetBackup Administration Console, in the left pane, select Media
and Device Management > Device Monitor.

2 At the bottom of the right pane, select the Disk Pools tab.

3 Select the disk pool.

4 The state is displayed in the Status column.

Determining OpenStorage disk volume state
Use the NetBackup nbdevquery command to determine the state of volumes in
OpenStorage disk pools.

To determine OpenStorage disk volume state

1 Determine the name of the disk volume. The following command lists the
volumes in the specified disk pool:

nbdevquery -listdv -stype server_type -dp disk_pool_name

The following is the path to the nbdevquery command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the
server type.
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To display the disk volumes in all OpenStorage disk pools on that vendor's
storage, omit the -dp option.

2 Display the volume state by using the following command:

nbdevquery -listdv -dv disk_volume -stype server_type

The state is either UP or DOWN.

Merging OpenStorage disk pools
Use the NetBackup nbdevconfig command to merge existing disk pools.

NetBackup updates the catalog records to show the correct location of the backup
images in those disk pools.

The following are the prerequisites:

■ The volumes in the two disk pools must have unique names.
OpenStorage requires that vendors use unique names for disk volumes in a
disk appliance.

■ All volumes must be from the same storage server.

■ If the secondary disk pool is referenced by storage units, you must delete those
storage units.

To merge OpenStorage disk pools

1 Change the state of each disk pool to DOWN.

See “Changing OpenStorage disk pool state” on page 89.

If backup jobs are assigned to a disk pool, the state change fails. Cancel the
backup jobs or wait until the jobs complete.

2 Merge the disk pools. The following is the command syntax. The primary disk
pool is the one you want to retain; nbdevconfig deletes the secondary disk
pool after the merge.

nbdevconfig –mergedps –stype server_type -primarydp disk_pool_name

-secondarydp disk_pool_name

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

3 Change the state of the primary disk pool to UP.

See “Changing OpenStorage disk pool state” on page 89.
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Removing a volume from an OpenStorage disk pool
Use the NetBackup nbdevconfig command to remove a volume from a disk pool.
The following are the prerequisites:

■ NetBackup image fragments cannot exist on the disk volume.

■ NetBackup jobs cannot be active on the disk volume.

By default, NetBackup automatically decreases disk pool capacity if you remove
a disk volume.

To remove a volume from an OpenStorage disk pool

1 Change the disk volume state to DOWN.

See “Changing OpenStorage disk volume state” on page 90.

2 Change the disk pool state to DOWN.

See “Changing OpenStorage disk pool state” on page 89.

3 Remove the volume by using the nbdevconfig command. The following is
the command syntax:

nbdevconfig -deletedv -stype server_type -dp disk_pool_name -dv

vol_name

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

For the server_type, the storage vendor provides the string that identifies the
server type.

4 Change the disk pool state to UP.

See “Changing OpenStorage disk pool state” on page 89.

Updating an OpenStorage disk pool to reflect plug-in updates
If an OpenStorage partner updates their plug-in, update the existing disk pools
to reflect the new functionality of the plug-in after you update the NetBackup
storage server.

Any disk pools that are created after the storage server is updated inherit the new
functionality.

To update an OpenStorage disk pool to reflect plug-in updates

◆ Run the following command on the master server:
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nbdevconfig -changedp -dp disk_pool_name -stype server_type

-setattribute attribute

The following is the path to the nbdevconfig command:

■ UNIX: /usr/openv/netbackup/bin/admincmd

■ Windows: install_path\NetBackup\bin\admincmd

See the following descriptions of the options that require arguments:

The name of the disk pool.-changedp

disk_pool_name

The storage vendor provides the string that identifies
the server type.

-stype server_type

Theattribute is the name of the argument that represents
the new functionality.

For example, OptimizedImage specifies that the
environment supports the optimized synthetic backup.
SpanImages specifies that backup images can span
across volumes on the disk appliance.

-setattribute

attribute

Viewing OpenStorage disk pools
Use the NetBackup Administration Console to view configured disk pools.

To view disk pools

◆ In the NetBackup Administration Console, in the left pane, expand Media
and Device Management > Devices > Disk Pools.

Monitoring OpenStorage storage capacity and usage
To monitor storage capacity and usage, see the following:

The DiskPools window displays a value that was stored when NetBackup polled the disk
pools. The value may not be as current as the value that is displayed in theStorageServer
window.

To display the window, in the NetBackupAdministrationConsole, in the left pane, select
Media and Device Management > Devices > Disk Pools.

The NetBackup
Administration Console
Disk Pools window.

See “Viewing OpenStorage disk reports” on page 95.The NetBackup Disk Pool
status report.
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The storage server view displays real-time values.

To display the window, in the NetBackupAdministrationConsole, in the left pane, select
Media and Device Management > Credentials > Storage Servers.

NetBackup
Administration Console
Storage Server window

The summary of active capacity-based license features in the NetBackup License Keys
dialog box. The summary displays the storage capacity for which you are licensed and
the capacity used. It does not display the amount of physical storage space.

To open the dialog box, in the NetBackupAdministrationConsole, select Help > License
Keys.

The NetBackup License
Keys dialog box.

The NetBackup OpsCenter also provides information about storage capacity and
usage.

See the NetBackup OpsCenter Administrator's Guide.

Viewing OpenStorage disk reports
The NetBackup disk reports include information about the disk pools, disk storage
units, disk logs, images that are stored on disk media, and storage capacity.

Table 6-5 describes the disk reports available.

Table 6-5 Disk reports

DescriptionReport

The Images on Disk report generates the image list present on the
disk storage units that are connected to the media server. The report
is a subset of the Images on Media report; it shows only disk-specific
columns.

The report provides a summary of the storage unit contents. If a disk
becomes bad or if a media server crashes, this report can let you know
what data is lost.

Images on Disk

The Disk Logs report displays the media errors or the informational
messages that are recorded in the NetBackup error catalog. The report
is a subset of the Media Logs report; it shows only disk-specific
columns.

Disk Logs
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Table 6-5 Disk reports (continued)

DescriptionReport

The Disk Storage Unit Status report displays the state of disk storage
units in the current NetBackup configuration.

For disk pool capacity, see the disk pools window in MediaandDevice
Management > Devices > Disk Pools.

Multiple storage units can point to the same disk pool. When the report
query is by storage unit, the report counts the capacity of disk pool
storage multiple times.

Disk Storage Unit

The Disk Pool Status report displays the state of disk pool storage
units. This report displays only when an Enterprise Disk Option license
is installed.

Disk Pool Status

To view disk reports

1 In the NetBackup Administration Console, in the left pane, expand
NetBackup Management > Reports > Disk Reports.

2 Select the name of a disk report.

3 In the right pane, select the report settings.

4 Click Run Report.

Reporting on Auto Image Replication jobs
The Activity Monitor displays both the Replication job and the Import job in a
configuration that replicates to a target master server domain.

Table 6-6 Auto Image Replication jobs in the Activity Monitor

DescriptionJob type

The job that replicates a backup image to a target master displays in the Activity Monitor as a
Replication job. The Target Master label displays in the Storage Unit column for this type of job.

Similar to other Replication jobs, the job that replicates images to a target master can work on
multiple backup images in one instance.

The detailed status for this job contains a list of the backup IDs that were replicated.

Replication
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Table 6-6 Auto Image Replication jobs in the Activity Monitor (continued)

DescriptionJob type

The job that imports a backup copy into the target master domain displays in the Activity Monitor
as an Import job. An Import job can import multiple copies in one instance. The detailed status
for an Import job contains a list of processed backup IDs and a list of failed backup IDs.

Note that a successful replication does not confirm that the image was imported at the target master.

If the SLP names or data classifications are not the same in both domains, the Import job fails and
NetBackup does not attempt to import the image again.

Failed Import jobs fail with a status 191 and appear in the Problems report when run on the target
master server.

The image is expired and deleted during an Image Cleanup job. Note that the originating domain
(Domain 1) does not track failed imports.

Import

About catalog backups to OpenStorage devices
Beginning with NetBackup 6.5.4, both full catalog recovery and partial catalog
recovery is possible from a primary hot catalog backup copy on disk storage.
Therefore, you can write a hot catalog backup to an OpenStorage disk appliance
and then recover the catalog from the primary copy. Caveat: the recovery must
be in the domain in which the catalog was created.

NetBackup 6.5.4 and later also support duplication of the catalog by using a Storage
Lifecycle Policy. However, limitations exist for recovery from non-primary copies
of the catalog backup or from catalog copies in other domains. Several tech notes
discuss the limitations and catalog recovery.

http://symantec.com/docs/TECH72098

http://symantec.com/docs/TECH72198

About restoring from backup copies
By default, NetBackup restores from the primary copy of an image. If you want
to restore from an optimized duplication copy or a direct to tape copy of a backup
image, you must specify the copy.

See “Restoring from a specific backup copy” in the Backup, Archive, and Restore
help.
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About restoring from a backup at a target master
domain

While it is possible to restore a client directly by using the images in the target
master domain, do so only in a disaster recovery situation. In this discussion, a
disaster recovery situation is one in which the originating domain no longer exists
and clients must be recovered from the target domain.

Table 6-7 Client restores in disaster recovery scenarios

DescriptionDoes client
exist?

Disaster recovery
scenario

Configure the client in another domain and
restore directly to the client.

YesScenario 1

Create the client in the recovery domain and
restore directly to the client. This is the most
likely scenario.

NoScenario 2

Perform an alternate client restore in the
recovery domain.

NoScenario 3

The steps to recover the client are the same as any other client recovery. The
actual steps depend on the client type, the storage type, and whether the recovery
is an alternate client restore.

For restores that use Granular Recovery Technology (GRT), an application instance
must exist in the recovery domain. The application instance is required so that
NetBackup has something to recover to.
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Troubleshooting

This chapter includes the following topics:

■ About OpenStorage log files

■ Troubleshooting OpenStorage credentials creation

About OpenStorage log files
You can monitor NetBackup OpenStorage activity and status by viewing the
NetBackup log files.

Some NetBackup commands or processes write messages to their own log files.
Other processes use Veritas unified log (VxUL) files.

The following are the identifiers for log messages for OpenStorage:

■ An sts_ prefix relates to the interaction with the storage vendor software
plug-in.

■ An encrypt prefix relates to interaction with the encryption plug-in.

■ An KMSCLIBprefix relates to interaction with the NetBackup Key Management
System.

Most interaction occurs on the NetBackup media servers.

Table 7-2 shows the NetBackup legacy logs for OpenStorage activity. For legacy
logging, the log directories must exist so that the utility can write log messages.

See “Creating NetBackup log file directories” on page 44.
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Table 7-1 NetBackup legacy logs

Processes that log the activityActivity

Messages appear in the log files for the following processes:

■ The bpbrm backup and restore manager.

■ The bpdbm database manager.

■ The bpdm disk manager.

■ The bptm tape manager for I/O operations.

Backups and restores

The tpconfig utility. The tpconfig command writes log
files to the tpcommand directory.

Credentials configuration

Table 7-2 shows the NetBackup VxUL originator IDs (OIDs) for the processes that
write VxUL log messages. VxUL uses a standardized name and file format for log
files. To view VxUL log files, you must use the NetBackup vxlogview command.
The following is an example of how to view the most recent 20 minutes of log
entries for the NetBackup Remote Manager and Monitor Service:

vxlogview -o 222 -t 00:20:00

Information about how to view and manage VxUL log files is available.

See the NetBackup Troubleshooting Guide.

Table 7-2 NetBackup VxUL logs

Processes that use the OIDOIDActivity

The nbjm Job Manager.117Backups and
restores

The nbemm process.111Device
configuration

The Disk Service Manager process that runs in the
Enterprise Media Manager (EMM) process.

178Device
configuration

The Storage Server Interface process that runs in the
Remote Manager and Monitor Service. RMMS runs on media
servers.

202Device
configuration

The Remote Disk Service Manager interface (RDSM) that
runs in the Remote Manager and Monitor Service. RMMS
runs on media servers.

230Device
configuration
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Troubleshooting OpenStorage credentials creation
The NetBackup tpconfig command creates the credentials for the storage server.

To troubleshoot credentials problems

◆ Examine the log files for the tpconfig command

See “About OpenStorage log files” on page 99.

See “Creating NetBackup log file directories” on page 44.
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